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Foreword

As much as 10 per cent of the world’s population and a much farger percentage of the world’s poor live in mountain regions.
Besides those living in the mountains, an additional 30 per cent of the world’s population is affected by or dependent on
mountain resources and their management. The Hindu Kush-Himalayan (HKH) region itself sustains approximately 150
million people and affects the lives of more than three times that number in the plains and river basins below.

The HKH Region is not only the world’s highest mountain region, but also its largest and most complex. It extends over a
distance of 3,500 km, from Afghanistan in the west to Myanmar in the east, and ranges from the Tibetan Plateau of China in
the north to the Ganges Basin of India in the south.

Due to the difficult topography of mountain regions, their inaccessibility, and lack of an accurate information base, the
decision-making process and implementation of development plans often do not meet the desired expectations. The inherent
diversity, marginality, and varying biophysical and socioeconomic values present great impediments to the use of Geographic
Information Systems (GIS). The ability to design and implement effective policies and programmes in this dynamic
environment is dependent on prompt and thorough analyses of current resource assets, their limitations, and changes. The
implementation of GIS can be facilitated if the data are collected, merged, and analysed to provide information and output in a
form that decision-makers can understand and use.

Geographic Information Systems (GIS) is one tool that addresses the problems of unscientific and inadequate use and
management of the natural resources and environment of the HKH Region. The process of using information in planning and
decision-making must be institutionalised, and the information must be in a readily available form. This is where a
Geographic Information System (GIS) comes into play. It integrates biophysical and socioeconomic data and indicates
alternative strategies for decision-makers.

Despite widespread use of GIS in the global context, in mountain environments it is somewhat limited. The implementation of
GIS should be considered in a different perspective for mountain regions than in the lowlands. The lack of experience in
handling truly three-dimensional GIS, given the prevailing technology, and dearth of trained manpower and accurate multi-
sectoral data hinder appropriate application.

Furthermore, the institutional hurdles are greater than the technological hurdles. A complementary approach between
various institutions is indispensable for success in implementing GIS.




ii

The technology is gaining increasing impdrtance, because it is estimated that more than 70% of all decision-making processes
are either influenced or dictated by some sort of geographic information. The basic advantage of the technology is its ability to
manage and perform complex processing of spatial data and their visualisation impact. Without an integrating methodology,
identifying viable technological and institutional options for sustainable development of mountain areas is not possible.

Today, a considerable amount of data on the natural resources of the HKH Region is available through satellite, and this is
essential for monitoring the ever-changing resource base. Advances in satellite image-processing and computer analysis have
made it possible to evolve a realistic, accurate, and uniform database. Resource assessment and monitoring data are becoming
widely available and are being distributed in formats affordable even by local resource-planning and management agencies.

Surendra Shrestha Egbert Pelinck
Regional Coordinator Director General
UNEP/EAP-AP 1ICIMOD

AlT-Bangkok, Thailand Kathmandu, Nepal



Durpcose of the wWorlksshop

The purpose of the current workshop is four-fold as follows.

i. to make participants aware of GIS and RS technologies for data analysis,

ii. to brief the participants on how GIS could be used effectively for decision-making and modelling purposes,
iii. to advocate the use of GIS technology for planning purposes and implementation strategy, and

iv. to provide hands-on experience and demonstration on applicability of GIS technology.
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MENERIS = An Introduction

MENRIS stands for Mountain Environment and Natural Resources' Information Service and is one of the programmes of the
International Centre for Integrated Mountain Development (ICIMOD). ICIMOD is the first international agency in the field of
mountain development for the Hindu Kush-Himalayan region. It brings together the experiences of the eight countries of the HKH
region, as well as experiences from other mountainous regions. Hence the justification for adaptation and dissemination of GIS
technology. A regional, coordinated effort towards the establishment of new, or strengthening existing, institutes to take
advantage of GIS technology and its applications is essential. It is with this basic objective in mind that MENRIS was established
with technical assistance from the Asian Development Bank (ADB) and other support from the ODA, UNEPF, GTZ, and UNITAR.

The primary objective of MENRIS is to disseminate GIS technology to ICIMOD member countries through a network of
institutions in the HKH region, conduct intensive training programmes, and provide technical back-up. Also, it works to promote
and assist information exchange on a compatible GIS platform among the participating regional member countries. Since its
inception, MENRIS has envisioned playing a catalytic role in promoting and sustaining GIS and RS technologies through intensive
training programmes, networking of institutions in the HKH region, and information base development through partnership
initiatives with national institutions.

MENRIS Infrastructure

With available resources, MENRIS has acquired modest hardware/software to facilitate the use of GIS technology. The
MENRIS facility consists of IBM RS/6000 workstations and a number of PC-based systems with the latest input/output
capabilities. The facility runs in an integrated networked environment, with IBM AIX and DOS/Windows operating
systems, to fulfill the following purposes.

* GIS Application Development

* Training Centre

* Data Input Activities

* RS and Image-processing Applications

MENRIS - An Intreduction 3
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The support from ESRI to provide ARC/INFO software at university prices is highly commendable. MENRIS has also acquired
ERDAS Imaging software for image processing. Besides, MENRIS has the IDRISI and ILWIS software programmes, and these are
basically used for training purposes.

During the establishment phase, MENRIS trained its staff in the latest GIS technology and developed training materials. Also,
development of pilot GIS case studies has been carried out to demonstrate the applicability of GIS technology.

Training

Many GIS applications have been developed for regions other than the mountains and very few institutions are engaged in GIS
training that is focussed on the mountain environment. Because GIS is a relatively new technology in the HKH region, the lack of
trained manpower is felt severely. Recognising this fact, the MENRIS programme places training as the highest priority activity.
The MENRIS Training Centre is playing an active role in developing and imparting training on GIS with applications associated
with the development issues of the mountain environment and its natural resources. Training materials have been developed
which are targetted at various audiences: decision-makers, managers, professionals, and technicians. These are being used to
conduct training for staff from agencies concerned with mountain development from participating Regional Member Countries
(RMCs).

University Level Training

The growing need for trained manpower in GIS can be best served by a university level training programme. Given the fact that
GIS is growing as a separate discipline, or science, on-the-job training with a software-oriented approach is not adequate to fulfill
the requirements for trained manpower. Owing to the non-availability of GIS infrastructure in the universities, MENRIS is
engaged in capacity-building in the universities of the HKH region. A concerted attempt is being made to introduce GIS
technology as a part of the university curriculum to fill this gap on a continuous basis.



Networking

A regional mechanism needs to be established to serve as a useful instrument for pooling resources, expertise, and facilities and to
work on common problems in the HKH region for the mutual benefit of participating regional member countries through a
network of collaborative institutions. It aims at a decentralised approach to regional cooperation in order to provide appropriate
technology and applications” development in the HKH region.

The partnership initiative is designed to extend the functional capabilities of national institutions by developing mutually
supportive relationships. These relationships initially focussed on training and GIS dissemination activities. Ultimately, MENRIS
seeks to develop a robust, productive GIS environment and attain the common goal of an accurate information base which can
then be used for natural resource and environmental applications in the region.

Database Development

The success of GIS depends upon the accuracy of the information base. The rapid growth of MENRIS datasets, along with the
increasing demand for environmental and natural resources’” data, emphasises the need for a coordinated approach to collection
and dissemination of digital data in the HKH region. Having established nodal agencies in the RMCs, MENRIS is making an effort
to develop a systematic database on a compatible platform for the specific mountain areas in collaboration with the concerned
national agencies. Defining common standards for a database on a sub-national/national and regional scale has been the first step

towards collection and dissemination.

Scope of Data

Given the vast scope and an inconceivable volume of data, a clear definition is needed concerning the number of factors to be
considered for incorporation into a database that would cater to those working for the development of mountain ecosystems. At
present, MENRIS is concentrating on the development of GIS for natural resource and environmental applications on various

scales.

MENRIS - An Intreduction 5
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Scale Applications

1:1 million regional-level analysis

1:25,000 country-level analysis

1:50,000/25000 province/ district-level analysis

Topography Settlements, Contours, Roads, Drainage, Land Use, Land Capability, Land Systems
Ecology Vegetation, Soil, Climate, Biodiversity, Forests

Economic activity Inputs, Products, Waste, Wealth and Resource Stores

Social Information Population, Health, Culture

The following are some key issues MENRIS is currently dealing within the process of database establishment.

e Data Standards

* Data Sensitivity

* Data Quality

* Data Dissemination Procedures

e Database Management and Update

Ensuring that the data collected by different institutions, under different programmes and for different purposes, are comparable
and compatible will ultimately facilitate the sharing of information in the public domain and provide a sound decision-making
process for the development of the mountain region.



ICIMOD

International Centre for Integrated Mountain
Development

Includes the Mountain Regions of:

Afghanistan, Bangladesh,
Bhutan, China,

India, Myanmar, and
Nepal, Pakistan.

MENRIS - An Intreduction
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MENRIS
1990 - 1995

. Mountain Environment and Natural Resources’
Information Service

* Basic Theme
Disseminate GIS Technology in the Hindu Kush-
Himalayan Region



Objectives

*  Awareness through Training/Workshops

*  Network: Regional Level Coordination

*  Capacity Building

*  Clearing House

. Build and Encourage Information Exchange

MENRIS - An intreduction
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GIS Technology:
€n Integrated Approach

To integrate biophysical data and socioeconomic data
To monitor the dynamically changing resource base
To indicate alternative strategies to decision-makers

To identify viable technological and institutional
options for sustainable mountain development



Establishment Phase

Installation of Hardware /Software

- In-House Training

Training

- Training Manuals, Pilot Case Studies
- Reviews

Partnership Initiatives

- Contact Key Institutions in the RMCs
- Contact External Institutions

MENRIS - An Intreducilien
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MENRIS Hardware Set-up

Resource Centre

- Two IBM RS/ 6000 Model 530 Units

- Four IBM X station 120 Units

- Five Pentium Units

- Two IBM 3BT Units and Four IBM 43/P Workstations (1996)
Units

Training Centre
- 5 Pentium Units with A3 size Digitisers

Data Input Activities

- Four Pentium Units with A0 size Digitisers
- A3 size scanner

Output Capabilities

- Tektronix A3 size colour printer
- HP Paintjet XL300 colour printer
- Two A0 size 8 pen plotters

- HP Inkjet 755C ("96)



MENRIS Software Resources

GIS/ RS Software

- Arc/Info 7.03 Workstation ( 6 Licenses)
- Arc/Info 6.1 Workstation (6 Licenses)

- PC Arc/Info 3.4.2 (12 Copies)

- Erdas Imagine 8.01 (3 Licenses)

- PCErdas Imagine 8.2 (6 copies)

- PCErdas 7.5 (1 Copy)

- ILWIS 1.4 ( 5 Copies)

- IDRISI 4.1 (5 Copies)

MENRIS - An Intreductien

13



Training Manual fer Policy-Makers

14

Implementation Phase

Mountain Focus GIS Training Centre
- improve training curriculum

- training for IPC agencies

- publish training handbooks

MENRIS Network Establishment

- formalise IPC nodes

- provide two cycles of training

- conduct collaborative case studies

- provide compatible hardware/software
- provide technical back-up

Resource Centre

- HKH district database build-up
establish focal points for research
encourage exchange of information
dissemination of studies, research



MENRIS Focal Nodes

ICIMOD |
MENRIS |

Special Affairs Division =
Dhaka

Bangladesh

Lab. of Resources &

Environment Info. System
Beijing

G. B. Pant Inst. of
Himalayan Env. & Dev
Almora

—— :
- Pakistan Forest Institute
Peshawar
Nepal )
55V

i = - i
- -

National Planning Commission

Kathmandu I

Border Areas & National
Races Dev. Affairs
Yangoon

MENRIS - An Intreduction
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MENRIS Node Implementation

Identification of Focal Node
First Cycle Training (ICIMOD)

Professional Level
Technical Level
Policy Level

Provision of Hardware/Software
Installation of GIS Centre
Second Cycle Training (Focal Node)

Professional Level
Technical Level
Policy Level
Managers Level

GIS Case Study Implementation District Based
Technical Back-Up



MENRIS Network - Bangladesh

Government ICIM& Odhers
MENRIS _/
Departments ] T
- Local Govt. Councils | \ :
Rangamati, Khagrachari | Sp aC1-a1- }_\ffalrs Donors
Bandarban, Chittagong ﬁF Division ADB. DANIDA
- Local Govt. Eng. Dept. SD’C SIDA
- Bureau of Statistics Chittagong Hill Tracts UNEI-; UNDP
- Bang. Agri. Res. Centre Board g
- Soil Res. Dev. Inst. it
- Surface Watre Modelling Centre Rikalia Corporate
- FAP 19 - ISPAN
S Lot S P =
Statistics 2> - Dkl
University
- Training 1 Jahangirnagar
- Level Cycle I & II, Cust., Adv. Chittagong
- Alumni 70 Bang. Univ. of Eng. and Tech.
- Inst. and Exp. DB Completed
- Equips 5+17
- Case Study Partially. Macro - Initiate
{- Database 250k - 1995. 50k - 1996

17
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MENRIS Network for Nepal

Government [CIMOD Donors

MENRIS /4 - i
- Mines and Geology i e ' - ADB
- Roads - UNDP
- Agriculture - DANIDA
- Survey . i - FINNIDA
- Forest National Planning . GIZ .
- Soil Conservation Commussion - World Bank g
|- Livestock - FAO E
- Local Development : National Steering - USAID =
- Urban/Housing . - UNEP B
. Linigation l Committee |

Torporations Universities

- National Telecommunications - Tribhuvan University
- Water/ Sewerage Board - Institute of Agriculture
- Electricity Authority - Institute of Forestry

e b R il el e S L =
s L ::.:-;,:5:5%.% e




Capacity Building - Training

Basic Courses

. Policy-makers (1 day)
- Planners, Decision-makers

. Professional (4 wks)
- Foresters, Engineers
- Economists, Agriculturists
- Scientists, Ecologists

*  Technical (4 wks)
- Data Managers,
- Cartographers, Draftsmen

Tailored Courses

. Managers’ Training (1wk)
- Project Managers

. Advanced ARC/INFO (2wks)
- Professional, Technical

*  Remote Sensing - ERDAS
- Professional (3wks)

. GPS Training
- Technical (1wk)

MENRILS - An Intredaclion
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Case Stadies

»  Melamchi Water Transfer

e Settlement Mapping Using GIS

»  Livestock Carrying Capacity

a Service Centre Location

*  Lamjung District Info. System

¢ Planning Agri. Development in
Gorkha-Baseline Data

*  Climatic Atlas

Collaboration with

Dept. of Mines
ODA

GTZ

UNDP

GTZ

GTZ

DOMH



GIS Databases

Scale

- 1:1 million

- 1:250,000

- 1:25,000/ 50,000

Scope of Data

- topography

- ecology

- socioeconomic activity

regional level
country level
district/ provincial level

21
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Database Issues

Data Access

Data Standardisation

Data Sensitivity

Data Quality

Data Dissemination Procedures
Database Management and Update



Fuature Strategies
Work Closely with National Institutions in the HKH Region in GIS
and Remote Sensing Applications

Build-up Regional Databases on Natural Resources and the
Environment

Advanced Training Centre

Exploit New Technology Development
Satellite/ Radar/GPS Technology
Conduct Collaborative Applications

Consultative Role

MENRIS - An Intredaciion
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MENRIS Appeal

* Encourage Information Exchange
* Encourage All Work in Digital Form

* Adhere to Compatible Hardware/Software
Platforms

* Stress Non-Duplication of Effort







Geographic Information Systems

iCRISE I
[ ILWS l

ARC!
INFO

L

SOFTWARE
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FOR
i II H EI RESOURCE
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GIS Evolation

revolution in information technology
- Computer Technology

- Remote Sensing

- Global Positioning System (GPS)

- Communication Technology

rapidly declining cost of computer hardware

enhanced functionality of software



The DPhilosophy of GIS

GIS has had an enormous impact on virtually every field that manages and analyses spatially distributed data. For those who are
unfamiliar with the technology, it is easy to see it as a magic box. The speed, consistency, and precision with which it operates is
truly impressive. Moreover, its strongly graphic character is hard to resist. However, the experienced analyst see the philosophy of
GIS quite differently. With experience, GIS becomes simply an extension of one's own analytical thinking. The system has no
inherent answers, these depend upon the analyst. It is a tool, just like statistics is a tool. It is a tool for thought.

Investing in GIS requires more than an investment in hardware and software. Indeed, in many instances this is the Jeast of
concerns. Most would also recognise that a substantial investment needs to be made in the development of the database. However,
one of the least recognised and most important investments is in the analysts who will use the system. The system and the analyst
cannot be separated —to put it simply, one is an extension of the other.

In many ways, learning GIS involves learning to think - learning to think about patterns, about space, and about processes that act
in space. As you learn about specific procedures, they will often be encountered in the context of specific examples. In addition,
they will often have names that suggest their typical application. But resist the temptation to categorise these routines. Most
procedures have much more general applications and can be used in many novel and innovative ways (Idrisi Student Manual).

The proliferation of GIS is explained by its unique ability to assimilate data from widely divergent sources, to analyse trends over
time, and to spatially evaluate potential environmental impacts caused by development. Such advances in information technology
have provided governments with the means to address the requirements of spatial data management in developing countries.

As the technology becomes widely adopted throughout the world, there are signs that its functions are gradually changing from
those of data collection and analysis to the promotion of visualisation, incorporating a variety of existing data sources and new
techniques such as multimedia and video. These techniques wiil ensure that the data, and in particular geo-reference information,
become more accessible to non-technical audiences.

An Overview of GIS
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Why GIS?

70% of the information includes some geographical
facts in the decision-making process

Ability to assimilate divergent sources of data both
spatial and non-spatial (attribute data)

Visualisation impact
Sharing of information

Analytical capability in a spatial context



Why €IS ?

Many professionals, such as foresters, urban planners, and geologists, have recognised the importance of spatial dimensions in
organising and analysing information. Whether a discipline is concerned with the very practical aspects of business, or whether a
discipline is concerned with purely academic research, geographic information systems can introduce a perspective which can

provide valuable insights.

GIS are a means to an end, not an end in themselves. The value of GIS lies not just in the immediate efficiency with which the
technology is implemented. Rather, it lies in how the technology helps us to think differently about the way we organise,
understand, and use spatial information. New appreciation of the importance of spatial location or geography in real world
analysis has emerged from the application of GIS technology. Predictions suggest that billions of dollars will be spent on GIS
technology and its applications. The basic factors affecting the diffusion of GIS are due to reasons described below.

First, the rapidly declining cost of computer hardware and, at the same time, exponential growth of computing power. Second,
user-friendly software and increasing functions of GIS software. Third, the visualisation impact of GIS corroborating the Chinese
proverb “a picture is worth a thousand words.” Fourth, more importantly, geography and data describing it are part of our
everyday lives; almost every decision we make is somehow dictated or influenced by some fact of geography; seventy per cent of
the decisions, we make are based on geographical considerations.

Thinking Spatially

Thinking spatially is a method of assessing a situation based on a perception of information that includes location. Part of this
method would typically include the ability to review the results of assessment or analysis in the form of a map or some sort of
report which identifiés a geographic location. GIS is a tool which enhances decision-making and planning processes. Most
planning applications, be they environmental or for natural resources, urban or agricultural development, require this approach.
The three-dimensional spatial analysis ability of GIS can help decision-makers to address the mountain-specific planning processes
in a more realistic way.

An Overview of GIS
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GIS

A computer-based
system, capable of
holding and using
data describing places
on the earth’s surface.

The real world
consists of many
geographies which
can be represented as
a number of related
data layers.




GIS Definition

Geographic data have traditionally been presented in the form of a map. Large-scale development of computer hardware and
software is increasing the use of maps dramatically. Many organisations now spend a large amount of money on Geographic
Information Systems (GIS) and on geographic databases. The costs of computer hardware and software are decreasing rapidly, and
programmes are becoming more user-friendly, making GIS accessible to a large number of people.

Burrough (1986) defines GIS as “a set of tools for collecting, storing, retrieving at will, transforming and displaying spatial data
from the real world for a particular set of purposes.” Aronoff (1989) gives a general description of GIS as “any manual or
computer-based set of procedures used to store and manipulate geographically-referenced data.”

More specifically, Aronoff (1989) defines GIS as "a computer-based system that provides four sets of capabilities to handle
georeferenced data: i) data input ii) data management (data storage and retrieval) iii) manipulation and analysis iv) data output."

In both cases the main objective of geographic information systems is to help and assist in decision-making processes for the
management and effective conservation of natural resources. Basic facts about Iocation and the quantity and availability of natural
resources are indispensable for more rational planning and intelligent development of ratural resources.

In order to be able to make adequate decisions, one has to have access to different sorts of information. For example, in the case of
the problem of industrial pollution, in order to analyse the impact on the environment, data should be available on various aspects,
ranging from geological, topographical, and hydrological information used for modelling the dispersion of groundwater pollution
to land-use and cadastral information to evaluate the environmental and economical implications of the actions that should be
taken and that will influence the decision concerning whether to clean up the mess or not. In this process, information of various
dimensions, present in different maps, also called data layers, should be combined. In other words, GIS are a very important tool
for these kind of applications.

An Overview of GIS
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GIS Historical Development

Earth Science

Computer Science
%51 2 i
Geography
CAD/CAM
Military Studies
nitary 1e GIS
Cartography e

e —

L Surveying and Photogrammetry

1. =

Remote Sensing

Spatial Mathematics

[ |
Urban Planning ii'!I
— — *




History of GIS

GIS, and the beginnings of simple spatial analysis, would not exist without geography and cartography. The contxibutions made
by information and systems’ development, in conjunction with the advancement in computer technology, have made GIS a

powerful analytical tool.

The GIS technology has evolved from geography and geo-type disciplines. Cartographic map production can be taken as the first
type of manual GIS. However, at a later stage, many other fields, such as civil engineering, computer cartography,
photogrammetry, remote sensing, global positioning systems, database management systems, earth sciences, and so on have
influenced the development of GIS and made it a truly interdisciplinary technology.

Canada was the pioneer in development of geographic information systems as a result of innovations dating back to the early
1960s. Much of the credit goes to Roger Tomilson for the early development of GIS. Although the field of GIS has been around for

the last 25 years, the real potentials have become apparent only since the late 1980s.

An Overview of GIS
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Handling Geographic Information

* Real-world

|

Sand and 5 AbStraCt -
Gravel St I 5. representation
Water Table st
Aquifer
e e— * Spreadsheets
i i » Database Management Systems (DBMS)

e Computer Aided Design (CAD)
s Cartographic Packages

* Photogrammetrical Software

e Image Processing Software

* Geographic features




Spatial Operations

Many computer programumes can handle geographic data such as those described below,

Spreadsheets (e.g., Lotus 1-2-3, QuatroPro). A spreadsheet can be thought of as a large imaginary piece of electronic paper that can
contain information in rows and columns, which is used for all sorts of (mathematical) operations for producing graphs.
Spreadsheets are often used in combination with GIS.

Database Management Systems (e.g., Oracle, dBase). A Database Management System (DBMS) is a set of programmes which is a
collection of information about things and their relationships to each other and which maintain and manipulate data in a database.
A DBMS only handles "attribute data" and cannot handle maps. It generally forms an integrated part of GIS.

Computer Aided Design (e.g., AutoCad). CAD systems are for capturing and manipulating drawings. Peint, line, and polygon |
objects are stored in vector format. A CAD system is like a part of a vector GIS. CAD software is highly developed and has very
good display capabilities, but, on its own, it is neither designed to carry out spatial operations nor use raster data types.

Cartographic packages (e.g., Aldus Freehand, CarthoGraphix). Cartographic packages or desktop mapping systems are for
selective search and display of information from spatial databases and for the production of high quality output maps which meet
cartographic standards. In this sense, they form a useful addition to GIS, since the output facilities of most GIS are still
unsatisfactory.

Photogrammetrical software (¢.g., DMS). Photogrammetrical packages are designed to take point sample data (mostly of terrain
elevations) from aerial photographs, satellite images, and GPS (global positioning systems) data, and then produce digital
elevation models (DEM) and contour maps. They form an important input source for GIS.

Image Processing Software (e.g., ERDAS). Image processing software is designed to handle satellite images, or scanned aerial
photographs. The information from such images can be extracted by several kinds of image enhancement techniques and
classification methods. Output maps from image processing software often form the input into GIS. These software packages are
not considered to be GIS. The difference between GIS and other software using geographic data is that only GIS permit spatial
operations on the data.

An Overview of GIS
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Maps and Spatial data

TOPOGRAPHIC

ZONAL

ISOLINE




What can GIS do?

Irrigated area

Planning zones

Electricity line

Real-world &

An Overview of GIS
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Questions GIS can answer

Thus far, GIS have been described in two ways: i) through formal definitions, and ii) through the technology’s ability to carry out
spatial operations, linking data sets together. One can also, however, distinguish GIS by listing the types of questions the
technology can {or should be able to) answer. If one considers a particular application carefully, there are five types of question
that sophisticated GIS can answer.

Location

Condition

Trends

Patterns

Modelling

What is at...?

The first of these questions seeks to find what exists at a particular location. A location can be described in
many ways, using, for example, place name, post code, or geographic reference such as longitude/latitude
or x and y.

Where is it...?

The second question is the converse of the first and requires spatial data to answer. Instead of identifying
what exists at a given location, one may wish to find location(s} where certain conditions are satisfied (e.g.,
an unforested section of at least 2,000 square metres in size, within 100 metres of a road, and with soils
suitable for supporting buildings).

What has changed since...?
The third question might involve both of the first two and seeks to find the differences (e.g., in land use or
elevation) within an area over time.

What spatial pattern exists...?

This question is more sophisticated. One might ask this question to determine whether landslides are mostly
occurring near streamns. It might be just as important to know how many anomalies there are that do not fit
the pattern and where they are located.

What if...?

“What if..” questions are posed to determine what happens, for example, if a new road is added to a network
orif a toxic substance seeps into the local groundwater supply. Answering this type of question requires
both geographic and other information (as well as specific models). GIS permits spabtial operation. For
example:



—

Name 0 Latitude itue Population
Kathingndd T 2742 N 85°20' E ; 421258
Lalitpur 27°41' N 85°18' E 115865
Bhaktapur 27°40' N 85°26' E 61405

Aspatial questions: Asking “What's the average number of people working with GIS in each location?” is an aspatial question -
the answer doesn't require the stored value of latitude and longitude; nor does it describe where the places
are in relation to each other.

Spatial questions: “How many people work with GIS in the major centres of Kathmandu Valley”, or “Which centres lie within
10 kilometres of each other?”, or “What's the shortest route passing through all of these centres?” These are
spatial questions that can only be answered using latitude and longitude data and other information such as
the radius of the earth. Geographic Information Systems can answer such questions.

GIS are not simply a computer system for making maps, although maps on different scales are created in different projections and
with different colours. GIS provide a truly analytical tool. The major advantage of GIS technology is that it facilitates identification
of spatial relationships between map features.

An Overview of GIS
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GIS Questions - Locations - What is at ... ?

Mangal Bazar, Lalitpur District

\Identiﬁer

Area
Ovner
Address

Yoned land use
Assessuient

Shrestha Niwas

215.712
Asha Ram Shrestha

14(210 Mahapal
Residential
NRs. 5000000

Who owns the land at Mangal Bazar, and what is an assessment?



GIS Questions - Conditions - Where is it ... ?

Mangal Bazar, Lalifpur District

Where are houses that you might consider buying located?

Residential L.and use
Assessed ai less than Rs., 500000

4 bedrooms
Made of local bricks

43
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GIS Questions - Patterns - What data are related ... ?

Mangal Bazar, Lalitpur District

What kind of patterns exist that provide potentials for vehicular accidents?




GIS Questions - Trends - What has changed since ... ?

Mangal Bazar, Lalitpur District

How much land has been used for residential construction since 19707

An Overviow of GIS
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GIS Questions - Models - What if ... ?

Mangal Bazar, Lalitpur District

Health Centre?
School?

Hotel?

Post Office?

Where would you want to open a new service centre?



LEFT BLANK
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Components of GIS

GIS

SOFTWARE
TOOLS

-+

RESULTS

DATABASE

ABSTRACTION
OR
SIMPLIFICATION

THE REAL WORLD




Components of GIS

Several components are involved in GIS technology.

Hardware

A computer and the associated peripherals are essential for handling spatial data in GIS. These devices are collectively known as
hardware.

Software

Software refers to the programmes that run on computers; these include programmes to manage the computer and to perform
specific functions. For example, Lotus, dBase, WordPerfect, and ARC/INFO are specialised software programmes designed to
perform certain tasks.

Database

A central theme to GIS is the database. A GIS database deals with spatial data. GIS facilitate integration of spatial and attribute
data and this makes GIS unique in contrast to other database systems. The beauty of GIS technology lies in the ability to assimilate
disparate sources of data and analyse them.

Human Input
People who work with GIS form the most important component. GIS constitute truly a interdisciplinary field and require varied

backgrounds of expertise, depending upon the applications. In addition, for technical management, a Hardware Specialist, System
Administrator, and Database Manager are required for a corporate GIS set-up.

Policy and Procedures

A methodology is a must to derive the results users need. Basically, this includes spatial analysis for the particular appli-cation. By
and large, this depends upon the institutional framework and its interest in exploiting GIS technology for decision-making.

An Overview of GIS
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@pplications of GIS

v Natural Resources’ Applications
. Environmental Applications
¢ Socioeconomic Applications

. Management Applications



CIS Applications

Computerised mapping and spatial analysis have been developed simultaneously in several related fields. The present status
would not have been achieved without close interaction between various fields such as utility networks, cadastral mapping,
topographic mapping, thematic cartography, surveying and photogrammetry remote sensing, image processing, computer science,
rural and urban planning, earth science, and geography.

The GIS technology is rapidly becoming a standard tool for management of natural resources. The effective use of large spatial
data volumes is dependent upon the existence of an efficient geographic handling and processing system to transform this data
into usable information.

The GIS technology is used to assist decision-makers by indicating various alternatives in development and conservation planning
and by modelling the potential outcomes of a series of scenarios. It should be noted that any task begins and ends with the real
world. Data are collected about the real world. Of necessity, the product is an abstraction; it is not possible (and not desired) to
handle every last detail. After the data are analysed, information is compiled for decision-makers. Based on this information,
actions are taken and plans implemented in the real world.

Some typical examples of GIS applications within natural resource planning are:

land-use planning and management
mineral exploration

environmental impact studies
management of natural resources
management of water resources
natural hazard mapping

forestry and wildlife management
soil degradation studies

monitoring desertification
agricultural development
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Sample GIS Applications

Land-use planning and management
Mineral exploration

Environmental impact studies
Management of natural resources
Natural Hazard Mapping

Forestry and wildlife management
Soil degradation studies

Monitoring desertification



The Planning Process
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Mapping Concepts

. Scale
. Resolution
. Accuracy

. Precision




e

Mapping Concepts

Maps have been used since the earliest times to portray information about the earth's surface. A map is also an information
system, normally representing on a certain scale and on a flat medium a selection of material or abstract features on, or in relation

to, the surface of the earth.

In the twentieth century, the pace of science and technology accelerated. This increase in pace created a demand for ever greater
volumes of geographic data to be presented in a map form more quickly and more accurately. With the development of
reconnaissance technologies, such as aerial photography or satellite-based remote sensing, there has been an explosion of
geographic data production, wider use, and more sophisticated analyses. Geographic data are now being generated faster than
they can be analysed. Some of the important properties of a map are:

¢+ Scale

¢+ Resolution
* Accuracy

* Precision

GIS Concepts
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Coordinate System

W Spherical coordinate system

E

y-axis

—

Data usually here

(0,0)

B Cartesian coordinate system

Origin

x-axls



Drojecticon System

The important globally used coordinate systems are:

» geographic coordinates (latitude, longitude), (degree, minute, second: DMS),
¢ UTM (Universal Transverse Mercator) co-ordinates (X,Y) (metres), and
e Lambert Conformal Conic (metres)

Very often a country has its own coordinate system which serves the entire country, but which is not valid for other
(neighbouring)} countries. Usually, it is possible to change from one coordinate system to another if the specifications of the
different systems are known.

Every flat map misrepresents the surface of the earth in some way. No map can rival a globe in truly representing the surface of
the entire earth. However, a map or parts of a map can show one or more, but never all, of the following: true directions, true
distances, true areas, and true shapes. If the area covered by the map is small enough the directions, distances, and areas are
reasonably accurate.

6IS Concepts
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Locating Nepal in Real-World Coordinates

26'15° 00’

80°00° 00”

*Global locations State Plane . .
Coordinate System Latitude & Longitude



The Geographic Coordinate system s a spherical coordinate system composed of parallels of latitude and mendians of longitude.
Both divide the circumference of the earth into 360 degrees which are further subdivided into minutes and seconds. Unlike the
equator in the latitude system, there is no natural zero meridian, In 1884, it was finally agreed that the meridian of the Royal
Observatory in Greenwich, UK., would be the Prime Meridian.

Mercator is an international rectangular coordinate system which extends around the world from 84 degrees North to 80 degrees
South. The warld is divided into 60 rones, each covering six (6) degrees longitude. Each zone extends three (3) degrees eastwards
and three degrees westwards from its central meridian Zones are numbered west to east from the 180 degree meridian. Because of
the small area covered by each rone, a high degree of accuracy is possible. For example, Nepal falls under zones 44 and 45.

Problems arise when a map extends into two UTM zones. The entire map will then have to be projected into one of the two zones.

The advantage of using UTM coordinates is its metric nature. Normal calculations can be performed on UTM coordinates, while
for geographic coordinates the minutes and seconds have to be first transformed into the decimal system.

Calculation of a map projection requires definition of the spheroid, As the earth is not a perfect globe (i.e.. the earth is 'flattened’ at
the poles), a spheroid Is defined in terms of axes lengths and eccentricity of the earth. Several principal spheroids are in use by one
or more countries. Differences are due primarily to calculation of the spheroid for a particular region of the earth’s surface. Some
impaortant are the Clarke 1866, the Bessel and the New International 1967. In the HKH Region, in general the Everest
spheroid is applied.
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SPOT PAN FPANCHROMATIC MODE

(10 » RESOLUTION)
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Z0 DEC 1988 KATHMANDU NEPAL

City Name

Address range to the airport
Address range to the park
Street No., Direction of Travel




Cecgraphic Data

Although the two terms, data and informaton, are often used indiscriminately, they both have a specific meaning. Data can be
described as different observations which are collected and stored. Information is data which is useful in answering queries or
solving a problem. Digitising a large number of maps provides a large amount of data after hours of painstaking work, but the
data can only render useful information if used in analysis.

Spatial and Non-Spatial data

Geographic data are organised in a geographic database. This database can be considered to be a collection of spatially referenced
data that acts as a model of reality. There are two important components of this geographic database: its geographic position and
its attributes or properties. In other words, spatial data (where is it?) and atiribute data (what is it?)

Spatial data

Geographic position refers to the fact that each feature has a location that must be specified in a unique way. To specify the
position in an absolute way a coordinate system is used. For small areas, the simplest coordinate system is the regular square grid.
For larger areas, certain approved cartographic projections are commonly used. Intermationally, there are many different
coordinate systems in use.

GIS Concepls



spatial Data for GIS




Computer and Spatial Data

Geometry Attributes

TOPOGRAPHIC

Imgated area
ZONAL
ISOLINE
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Dasic Types of Spatial data

Most GIS deal with four (4) types of geographic data: points, lines, areas, and continuous surfaces.

Point data

Points are the simplest type of spatial data. They are zero-dimensional objects with only a position in space but no length.

Line data

Lines (also termed segments or arcs) are one-dimensional spatial objects. Besides having a position in space, they also have a
length.

Area data

Areas (also termed polygons) are two-dimensional spatial objects with not only a position in space and a length but also a width
(in other words they have an area).

Continuous surface

Continuous surfaces are three-dimensional spatial objects with not only a position in space, a length and a width, but also a depth
or height (in other words they have a volume). These spatial objects have not been discussed further because most GIS do not
include real volumetric spatial data.

GIS Concepts
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Data Capture

Aerial
Photography

Remote Sensing

Digitising

Scanning




Data Capture

The functionality of GIS, however, relies on the quality of data available, which, in most developing countries, is either redundant
or inaccurate. Although GIS are being used widely, effective and effiient means of data collection have yet to be systematically
established. The true value of GIS can only be realised if the proper tools to collect spatial data and integrate them with attribute
data are available.

The vector data model uses three methods of representing data: points, lines, and polygons, of which the x and y coordinates are
stored, together with the relationships between the coordinates, lines, and polygons.

In practically all GIS systems, the conversion from analog maps into digital maps, called digitising, is carried out using the vector
data structure. Digitising map data can be carried out in two ways, apart from manually entering the coordinates via the keyboard,
which, for obvious reasons, is not very popular: manual digitising and raster to vector conversion.

GIS Concents
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Attribute Handling
District Name Area Population
Kathmandu 395 sq. km. 6,75,341
Lalitpur 385 sq. km. 2,57,086

Bhaktapur 119 sq. km. 1,72,952




Attribute data

The attributes refer to the properties of spatial entities. They are often referred to as non-spatial data since they do not in
themselves represent location information.

In addition to the spatial representation of a feature, each entity usually has a number of important properties or attributes. These
attributes may be nominal (identity, e.g., maize, granite, lake), ordinal (ranking, e.g., class 1, class 2, class 3, and so on), or scalar
(value, e.g., water depth, elevation, erosion rate, and so on).
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Data Linkage
Data Linkage
Exact Matching Non-Exact Matching
Hierarchical Fuzzy Matching

Matching



Data Linkage

A GIS typically links different sets. Suppose you want to know the mortality rate due to cancer among children under 10 years of
age in each country. If you have one file that contains the number of children in this age group, and another that contains the
mortality rate from cancer, you must first combine or link the two data files. Once this is done, you can divide one figure by the
other to obtain the desired answer.
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Exact Matching
| Name Population Name Avg. Housing Cost
Aenchok 4038 Aenchok 30,500
Baireni 7030 Baireni 22,000
MNaubesi 10777 Naubesi 100,000
Salyantar 5798 Salyantar 24,000
L Gajuri 5606 Gajun 24,000
e ——— —
Name Population Avg. Housing Cost
Aenchok 4038 30,500
Baireni 7030 22,000
Naubesi 10777 100,000
Salyamtar 5798 24,000
Gajuri 5808 24,000




Fxact Matching

Exact matching occurs when you have mformation in one computer file about many geographic features (eg., towns) and
additional information in another file about the same set of features. The operation to bring together is easily achieved by
using & key common to both files — in this case, the town name. Thus, the record in each file with the same town name is
extracted, and the two are joined and stored in another file.
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Hierarchical Matching

Kathmandu District

Tract Town Population
101 Kathmandu 60,000
102 Maharangung | 45,000
103 Patan 35,000
104 Dillibazaar 36,000
106 Baneswor 657,000
106 Nakkhu 25,000
107 Kupondole 58,000




Hierarchical Matching

Some types of information, however, are collected in more detail and less frequently than other types of information. For example,
financial and unemployment data covering a large area are collected quite frequently, On the other hand, population data are
collected in small areas but at less frequent intervals, If the smaller areas nest (i.e., fit exactly) within the larger ones, then the way
to make the data match the same area is to use hierarchical matching — add the data for the small areas together until the grouped
areas match the bigger ones and then match them exactly.

The hierarchical structure illustrated in this diagramme shows that this dity is composed of several tracts. To obtain meaningful
values for the city, the tract values must be added together.




Fuzzy Matching

Soil Type Crop Productivity

Combined Layers

When data boundaries between layer do not match, the layers can be jointed, creating a
new layer containing the characteristics of both layers.



Fuzrry Matching

On many occaslons, the boundaries of the smaller areas do not match those of the larger ones. This occurs often while dealing with
environmental data. For example, crop boundaries, usually defined by fleld edges, rarely match the boundary between soil types.
if you want to determine the most productive soil for a particular crop, you need to overlay the two sets and compute crop
productivity for each and every soll type. In principle, this s like laying one map over another and noting the combinations of soil
and crop productivity.

A GIS can carry out all of these operabons because it uses geography, or space, as a common key between the data sets
Information is linked only if it relates to the same geographical area.

Why is data linkage so important? Consider a situation where you have two data sets for a given area, such as yearly income by
county and average cost of housing for the same area, Each data set might be analysed and /or mapped individually. Alternatively,
they may be combined. With two data sets, only one valid combination exists. Even if your data set may be meaningful for a single
query you will still be able 1o answer many more questions than if the data sets were kept separate. By bringing them together, you
acd value to the database. To do this, vou need GIS,
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Four Major GIS Fanctions

data capture
- graphic data: digitised, converted from existing data

- attribute data: keyed-in, loaded from existing data files

data storage and manipulation

- file management
-  editing

data analysis

-  database query
- spaltial analysis
- modelling

data display
- mﬁpﬁ,
3 reports




Maior Functions of GIS

Data Gapture. Data used in GIS often come from many different sources, are of many types, and are stored in different ways. A
GI5 provides tools and a method for the integration of different data into a format to be compared and analysed, Data sources are
mainly manual digitisation/scanning of aerial photographs, paper maps, and existing digital datasets. Remote-sensing satellite
imagery and GFS are promising data input sources for GIS.

Database Management and Update. Afier data are collected and integrated, the GIS must provide facilities which can contain and
maintain data. Effective data management has many definitions but should include all of the following aspects: date security, data
miegrity, data storage and retrieval, and data mamiznance ahilites,

Geographic Analysis. Data integration and conversion are only a part of the input phase of GI5. What is required next 1s the ability
to interpret and to analyse the collected information quantitatively and qualitatively. For example, a satellite image can assist an

Itural scientist to project crop yield per hectare for a particular region. For the same region, the scientist also has the rainfall
data for the past six months collected through weather station observations. The scientist also has a map of the soils for the region
which shows fertility and suitability for agriculture. These point data can be interpolated and what you get is a thematic map
showing isohyets or contour lines of rainfall

Presenting Results. One of the most exciting aspects of GIS technology is the variety of different ways in which the information can
be presented once it has been processed by GIS. Traditional methods of tabulating and graphing data can be supplemented by
maps and three dimensional images. Visual communication s one of the most fascinating aspects of GI5S technology and is
available in a diverse range of output options.
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Types of GIS
. Vector GIS
. Raster GIS
. Hybrid GIS

Technology is moving towards hybrid GIS

Raster Vector Integration



Eepresentation of Ceotraphic Data

The representation of geographic data is primarily driven by the types of data structure. This is often termed a dats model. A data
model is a formal system in which a set of precisely defined objects can be manipulated in accordance with a set of
predefined rules, without any regard for the ‘meaning’ or real-world interpretation of those objects or rules. Reality is an informal
system. a systemn of immense complexity and a system with an infinite amount of imformation. The difficulty in defining a
ve and useful data model is to find a formal system whose behaviour mimics the informal behaviour of the real world

as closely as possible

A GIS data model, pften known as a geo-relational model, is a formal collection of spatial operators that act on a spatial database in
order to relate the user to the real world. GIS uses primarily two spatial data models: vector and raster.

Vector and mster models have both advantages and disadvantages. Each approach tends to work best in situations in which the
spatial information is to be treated in a manner that closely resembles the data model. For example. the raster model s generally
well suited when the geographic information of interest is the spatial variability of a phenomenon; network analysis is best
performed with data stored in the vector model.

The spatial data are represented in digital form in two basic types of spatial data model.

= awvector model and
* araster model.

The vector data model uses three methods of representing dala: points, lines, and polygons, of which the x and y coordinates are
stored, together with the relations between the coordinates, lines, and polygons.




Training Manual lor Policy-Makers

Vector Representation

Original map
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The vector Model

In a vector model, the positions of points, lines, and areas are precisely specified. The position of each object is defined by a (series
of) coordinate pairs. A peint is described by a single X-Y coordinate pair and by its name or label. A line is described by a set of co-
ordinate pairs and by its name or label. In reality, a line is described by an infinite number of points. In practice, this is not a
feasible way of storing a line. Therefore, a line is built up of straight line segments. An area, also called a polygon, as a line is
described by a set of coordinate pairs and by its name or label, with the difference that the coordinate pairs at the beginning and
the end are the same,
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Raster Representation

Original Map
Map data ®
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Raster representation
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The raster model

The simplest way of storing spatial data is through the raster model. In this model, the spatial data are organised in cells or pixels
(hercafter referred to as pivels). These pooels are the basic units for which information is explicitly recorded. Each pixel is only
assigned one value.

A point is described by the position of a single pixel. Usually, the position of the cell is defined by a row and column number, A
pixel is assigned one numerical value. The name of the point 18 not explicitly recorded within the pixel itself. A legend has to be
available to determine which name belongs to which digital number. A line and an area are described by a set of connected pixels
with one numerical value. In the raster model there is no basic difference in how points, lines, and areas are stored,
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Advantages and Disadvantages of the Raster and Yector Data Models

e —————————————— : o m— e ———— —
o ey e
VECTOR MODEL .
Advantages F Advantages e
- simple data structure - compact data structure
- easy and efficient overlaying - efficient for network analysis
- compatible with RS imagery - efficient projection transformation
- high spatial variability is efficiently represented - accurate map output

- simple for own programming
- same grid cells for several attributes

Disadvantages Disadvantages

- inefficient use of computer storage - complex data structure

~ errors in perimeter, area, and shape - difficult overlay operations

- difficult network analysis - high spatial variability is inefficiently represented
- inefficient projection transformations - not compatible with RS imagery

- loss of information when using large cells
- less accurate (although attractive) maps




The Integration of Vector and Raster System - Hybrid System

21



An Example of Raster and Vector Integration




Principal Components and Functions of an Ideal GIS

Packages
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Implementing GIS

Establishment Phase

- hardware/ software
- trained manpower
- pilot study

Application Development Phase

- Database Standards
- Database Development
- GIS Applications
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GIS Development Phase

Establishment
Phase

Inventory Type Application Applications for
Management

1-2 Years

2-4 Years 4 years onwards




GIS Costs

Data Input
(Labour Intensive)

Database Maintenance &
Management

Hardware/Software

Personnel

Total

70%

10%

10%

10%

100%
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Costs of GIS

Relative Costs

Hardware

1960

Present +20 yrs
Time




Organisational Aspects of GIS
u
Information and Aims and Queries from
Management Management
Information

Systems

Data Gathering
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GIS Technology

Requirements

*  Highly Reliable Data Storage

Flexibility: growth and expansion

*  Communication, Networking, Interoperability

Optimisation for Data Management




GIS Technology

Questions

Does the system have the software functions required to
perform applications?

Do the hardware components allow you to perform these
functions in an efficient manner and provide:

- growth in respect to data quantities
- analytical work?
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GIS Technology Trend

*  Corporate GIS
*  Desktop GIS

*  Data Transparency
*  User Transparency




GIS Technology Trends
*  Computer Technology
- Distributed Computing

Client-Server Architecture
Multitasking Capability

- High Quality Graphics
3-D or Topographic modelling
- Network Environment
Network Transparency
- Graphical User Interface

User-friendly Software
Usability Engineering

impiementing GIS 105
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GIS Technology Trends

*  Database Management Technology

- Relational Database Management Systern (RDBMS)
- Object Oriented Database Technology

*  Spatial Modelling
- Powerful Software Tools

- Spatial Database Management
- Artificial Intelligence

Neural Networks
Experl Systems




GIS Technology Trends

Satellite Technology
Remote Sensing
RADAR Satellite

Global Positioning System (GPS)
Scanning Technology
Communication Technology
Internet
High Speed Modem

Multimedia Technology
Audio/Video
CD-ROM

Printing Technology
True Colour Printing Capability

107
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Integration of GIS Technology

Raster GIS

Remote
Sensing

TECHNOLOGY-DRIVEN 1950
RESULT-DRIVEN 1990

Vector GIS




Possible Peripheral Devices

= =
; Printer

Printer
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Multimedia GIS

= __od o0

- i
CD-Audio &'elie o
Stareo
Audio
Digitiser

Videodisk

=P

VCR/
Video
Camera




Software for GIS

Data Transform

GIS Database
Management

Spatial Analysis
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GIS Software Level

User

‘ GIS Applications

- = GIS Commands

Window Manager

Operating System




@Arc/Info

Primarily a vector-based system
Enterprise GIS solution
Functionality

Larget market share
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Arc/Info Modules

ARC
Tools

Data
Conversion

Network




fArcView

Display and Query GIS Database
Windows'- based software
Presentation

Graphical User Interface

Options for Raster data
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GIS Trends In The Commercial Sector

Project-oriented GIS uses
Mainframe-based GIS

Minicomputer-based GIS

Small area databases

Isolated users

L

-

L3

Database-oriented GIS uses
Mini-Computer-based GIS

Workstation/
Personal Computer-based GIS

Global databases

Networked users.




National GIS Considerations

Steering Committee

- A Policy Board
- Local User Representation
- University Representation

Coordinating Agency

- Training
- Database Standards and Development

- Data Distribution and Archiving
- Technical Advice and Hardware/Software
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..Contd.

*  Success Stories and Pilot Studies

- Successful GIS Strategies
- Local-level Pilot Study

- Regional-level Pilot Study
- National-level Pilot Study

*  Implementation Strategy and Growth Plan

*  Annual Programme of Information Sharing and
Programme Assessment




Policy Formation Consideration

*  Result Driven Vs, Technology Driven
*  Education/ Training
* Institutional Framework/ Initiative

. Standardisation

Data Standards

A successful GIS implementation demands a paradigm

shift at the Policy and Institutional level
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GIS System Development Phase

*  Awareness
*  Development of System Requirements

*  System Evaluation

*  Implementation Plan




Database Issues

Data Standards

Data Sensitivity

Data Quality

Data Dissemination Procedures

Database Management and Update
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GIS Chalienges

*  Data Capture

*  Data Modelling

*  Accuracy

*  Volume

*  Analysis

*  User Interfaces

*  Cosls and Benefits

*  Impact on Organisations
*  Education and Training




Implementation Alternatives

Low High Very High Nearly Complete
Time until system Long Long to Short Very Short Not a problem
functions Moderate
Initial cost Low Moderats Moderate High High
Labour costs paid by High Lower Moderate Moderate Very low
uSeT
Risk and uncertainty High Lower Low Low Low
Customising Complete Complete Moderate Moderate Viaries
Technical skill Extremely High Moderate Moderate Quite Low
required of user High
Ulse of existing High High Moderate Low Very Low
resources
— —
Source: Adapted from Dangermond and Smith 1950
Implementing  6IS 123
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Elements of GIS Project Success and Failures

Time estimates Thoughtful Rushed or prolonged
Expectation Balanced Exaggerated

Source:Antemucct, Brown, Croswell, and Kevany (1991). Copyright 1991 by Chapman & Hall,
reprinted by permssion




Effectivenesns of Tactica

High

Low

Implementing a GIS

Probability of
Type Il and
Type lll

errors

High acceptance,

High
probability
of
implementation

SUCCess

misuse
High Probability of
probability Type | and
of Type IV errors

implementation

failure Low acceptance,
low use
Low High

Effectiveness of Strategy

Strategyftactics effectiveness matrix. From Schultz, Sleving, and
Pinto (1987). Copyright 1987 by Randy L. Schultz, Dennis P. Slevin,

and Jeffrey K. Pinto. Reprinted by permission.

Implementing GIS
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Using €IS to Soive a Spatial Droblem

The exercise provides an opportunity to see how GIS can solve a sumple spatial analysis problem. In the exercise, we will
determine the total area of agricultural land adjoining existing roads. This analysis could be used to determine the rice production
lost due to construction or expansion of roads. For this exercise, we will select a rectangular area around the Ring road in
Kathmandu Valley. The input land use and road maps, used for analysis, are on a scale of 1:50000 and the Universal Transverse
Mercator (UTM) projection. First, we will look at the information on each of these maps, We will then combine the maps and
determine the area of agricultural land within 100 metres of the existing roads.

Geographical Analysis
Land use
Roads Buffer | 100 metres buffer

Bsing GI5: A Lab Exerciss 129
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Here is what the maps look like.
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Start ARCANFO, and the menu system in the demo workspace

»» C»CD \GISTRN\ DATA
>»C, ARC

The |ARC] prompt appears.
Start the menu system and begin this demo;
|ARC] &RUN INTRO.

u Draw and guery the contents of the LANDUSE and ROADS coverages

(A TORETTTubd — TQen  ow T Selecton ] Clear (G

ri v T R -
e T B g

§ § § 9yPpog
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The display of the LANDUSE coverage will look similar to the figure below:

—— ——y

e -

e

LI

Agricultlure
Grazing
Urban

Forest

Each polygon is shaded according to the type of land use. Here is what the shades represent.




Select QUERY and choose the LANDUSE option

[ Amsbss [ raw == [y Tim [Selection | Clear [Qu ]
Kosds

Move the crosshairs over one of the polygons and press the left mouse button or the enter key on the keyboard. The attributes of
the polygon are displayed. Move the crosshairs over one of the lines and press the enter key to quil.

Here are the codes for all the land use types.
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To select and draw only the agriculture polygons, first clear the screen.

| Assiyu | Deaw _ | Labed | Query [ Liss | Selextion [Cear [ Qu ]

Select CLEAR from the menu (o erase the scyeen.

[ Analysis [ Draw [ tabel [ Quey [t [Sdeton |G [ |
o featues. |
Switch leatires
Clear features
RETURN

Choose SELECTION, then Choose features.

Reselect - select a set of coverage features

[coverage] | LANDUSE
[feature class] ! PFOLY

MNow in the next menu that appears, enter LUCODE =2. Press <ENTER> to start the selection process.

P ———————



LANDUSE polys: 53 of 71 selected.

Now the agriculture polygons are selected. To draw them,
select the DRAW option and then choose LANDUSE ON.

[ Analysis L Eiraw

| Query

| List

| Selection

| Clear

[ Quit

o Off

Roads On Off
Rivers On Off
Landcap Cn Off
Panchaya On Off
Village On Off
Zoom: In

Study Area

Coverage
PAN
User defined
RETURN

Only the agriculture polygons are drawn.

Using GIS: A Lah Exercise
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Mow draw the roads.

Choose DRAW again, and then ROADS ON
The display of agricultural land areas and the roads will look similar to the figure below.

i i T

Before proceeding to the next step,
= select CLEAR to clear the display.




Create a 1{-metre buffer area around the roads.

Select ANALYSIS and choose BUFFER.

| Query [ List [ Selection [ Clear | Qu ]

Reselect - creafe constant width buffers

[input coverage| : ROADS
[feature class] - ROADBUF
[Puffer distance] 100
[buffer feature] LINE
QK MENLU CANCEL

After you've filled out the form carrectly,
press the OK button,
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When the buffer is finished, the main menu appears.
Now display the buffer area.

To draw buffer around roads,
select USER DEFINED from the DRAW column.

[ Anahss =y [= [Sciecion | Clewr Jo=. |
Landuse On o
Roady On off
Ehen O Oof
Lamdcap On Ooff
Panchaya On ofr
Village an off
Lo, in

Sty Area
Coverage
Qm
RETLIRN




Fill in the form below to draw the ootline of the bulfer area polygon.

Draw a user specified coverage with a specified symbol

<cOverage> : ROADBUF
{symbol| =1
<feature to draw> : OUTLINES
oK MENU CANCEL

Press the OK bultton.
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To view the attributes for the buffer polygons,
choose LIST and then USER DEFINED,

[Anahn [ Orow [isbel [Quey | eternon | Clean | Qui |




Fill in the form below with the coverage name as ROADBUF and feature class as POLY to display the attributes.

Display item values for the specified coverage

|coverage| : ROABUF
[feature class] ¢ POLY
(item) :
(item)
MENU CANCEL

Press the DK button to view the attributes

- SRECNO . AREA PERIMETER ROADBUF ROADHUF_ID INSIDE
1 - 74E+08 BEIBS. 1600 1 0 1
2 18316940.0000 177013.9000 2 1 100
3 36638010000 10565,6300 3 2 1
4 9629993.0000 168379600 4 3 1
5 1547486000 22169650 § 4 1
[ 1743105.0000 55676010 1] 5 1
7 12845800000 7E13,0810 7 ] 1
8 2BD0595.0000 7482.5050 8 7 1
9 33047870000 768935090 9 8 1
10 SZ13054.0000 10844 6300 10 9 1
1 S345882.0000 49632200 11 10 1
12 694351.2000 52803910 12 1 1
13 12449050000 47143450 13 12 1
Wsing GIS: A lab Exercise 141
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Press the <ENTER> key or click the mouse.
Before proceeding to the next step,

| Analysis | Draw | Label | Query List | Selection F Clear | Quit |
select CLEAR to clear the display.
m Overlay LANDUSE and ROADBUF using the UNION command and display the results
| Anglyss. | Draw | Label | Query | List | Selection | Clear | Quit
Fudfer
‘Oweriay: . Union
Intersect
ldentify
Statistics
RETURN

Select ANALYSIS from the menu, then select OVERLAY: Union




Fill in the form below to create composite coverage LANDBUF from the two input coverages LANDUSE AND ROADBUF.

Union - spatially join two polygon coverages using union operation

[input coverage] g LANDUSE
[union coverage] :  ROADBUF
[output coverage] ! LANDBUF
OK MENU CANCEL

Press the OK button 1o execute the form.

When the menu reappears, the UNION 15 complete and the new LANDBUF coverage has been created. To display the results of
the Union operation, first draw the LANDUSE coverage.

Select DRAW and LANDUSE ON.

Highlight the area of interest. using a solid shade pattern, and “white out’ those areas outside the 100-metre road buffer. To do
this, select those polygons that lie outside the buffer (all polygons that have a value of 1 for the {tem INSIDE),
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Choose SELECTION, then CHOOSE FEATURES.

Fill in the form as shown.
Press the QK button.

Reselect select a set of coverage features

[coverage} ! LANDBUF
[feature class] ] POLY

OK MENU CANCEL

In the next menu that appears, enter the selection criterion.

Logical expression

INSIDE = 1

Press the <ENTER> key to start the selection process. A message appears:
LANDBUF polys 170 of 275 selected.

Now, shade these polygons.




Fill in the form as shown.

Draw a user-specified coverage with a specified symbol

[coverage] : LANDBUF
[symbal] i
[feature to draw] SHADES
oK MENU CANCEL

Press the OK button to shade the polygons outside the buffer
You can clearly see all the land-use types within the 100-metre buffer. Now highlight the buffer by drawing the ROADBUF

coverage.

Select Draw, then choose User defined.

Fill in the form as shown

Draw a user-specified coverage with a specified symbol

[coverage] : ROADBUF
|symbal] 3 -8
[feature to draw] ;. OUTLINES
QK MENU CANCEL
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Press the OK button to draw the road buffer, Finally, draw the road network
Salact Draw, then chooss Roads on.

The display should look similar to the figure below




Select List, then choose User defined.

Fill ini the form as shown,

[Drisplay - item values for the specified coverage

[coverage] : LANDBUF
[feature class] - POLY
{tem) I
(item)
(item)
OK MENU CANCEL

Press the OK button.

Notice how the polygons have attributes from both the LANDUSE and the ROADBUF coverages, including LUCODE and INSIDE,
respectively. Next, find the total area of agricultural land within 100 metres of the roads.
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Generate statistics for the analysis

Select those polygons that are inside the buffer.

Choose Selection, then Switch features.

| Analysis | Draw | Label | Query List [ Selecuon { Clear | Quit

Clear features
Save Selection
RETURN

Fill in the form menu as shown.

Nselect - switch the select set of coverage features

[coverage] : LANDBUF
[feature class] 3 POLY
OK MENU CANCEL

Press the OK button to switch the selected set of polygons.

LANDBUEF polys: 105 of 275 selected.




Only polygons with the buffer are selected. Save these selected features on a file on which statistical analysis is to be performed.

Choose SELECTION, then SAVE SELECTIONS.

| Analysis | Draw | Label | Query | Las IM : § Clear | Qi

Chasorte feaiures
Switch features

Clear sclecilons
RETLIRM

Fill i the form menu as shown.

Infofile - save the selected set of coverage features

<coverage> t LANDBUF
[feature class] : POLY
[info_file] : LANDBUF.FRQ
Ok MENU CANCEL

Press the DE button.
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Now, calculate the total area of each land use type within the 100-metre road buffer.

Select ANALYSIS, then choose STATISTICS.

| Labe | Query | List T Seiection [ Clear [ Qutt ]

| RETURN
Fill in the form menu as shown.
Frequency - compute summary statistics for coverage feature attributes
[input file| : LANDBUF.FRQ
{item) :
(item)
[item) :
[summary item| : AREA
OK MENU CANCEL

Press the OK button to execute the form.

R ———————e



MNow, calculate the total rice pmdmﬁu:m Jost within the T00-metre road butter

Select Analysis, then choose Statistics.

| sy | Cwaw | Label [ Guiery
()
Inérraee!
ke paiFy

Fill in the form menu as shown

Frequency - compute summary statistics for coverage feature attributes

[input file]
(item)

(Lfeem)

(item)
[summary item)|

OK

: LANDBUF.FRQ

. PRODUCE

MENU CANCEL

Press the OK button to execute the (orm
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Introduction To Arcview

This introduces you to ArcView version 2.0, shows you how to start it, and directs you to on-line sources of information.
What is ArcView ?

ArcView is a powerful and easy-to-use tool that brings geographic information to your desktop. AncView creates an environment
to display and query the contents of a spatial database. It allows you to explore the database. display all part of ils contents, ask
questions, display or save results, and pass information or graphics on o other applications.

What Can You Do with ArcView ?
Here are some of the key tasks you can accomplish with ArcView,

Display ARC/INFO Data

Display tabular data on a view

Import tabular data and then join it to the data in a view o display it geographically
Find the attributes of any features

Classify features with different symbols according to thetr attributes
Select features according to their attributes

Find places where certain features comncide

Summarise and generate statistics on the attributes of features
Create charts showing the attributes of features

Lay out a map and print it

Lay out a map and éxport it for use in another applxcation
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Chapter 1

Projects and Views: Managing Your Work and Displaying and Querying Spatial Data

What is a Project 7

All the components of your ArcView session - views, tables, charts, layouts, and scripts - are conveniently stored in one file called
a project. The project file shows you the contents of your project and makes it casy to manage all your work. Project files have the
AFR extension.

When you open a project file, the components in the project are listed in the Project window. From the Project window, you can
add or remove components from your project and give a component a descriptive name,

What is a View 7

A view is an interactive map that lets you display, explore, query, and analyse geographic data in ArcView, A view defines the
geographic dats you use and how to display it, but it does not contain the geographic data files themselves.

S




A view is actually a collection of themes, A theme represents a distinct set of geographic features in a particular geographic data
SOUTTE.

What is a theme 7

A theme is a set of geographic features in a view. A theme represents one of the following sources of geographic data:
* anspatial data source, such as an ARC/INFO coverage,

= animage data source, such as a satellite photo, and

* atabular data source containing events, such as a table with X, Y coordinates.
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The themes in a view are listed in its Table of Contents. For example. a view of a city might have one theme representing major
highways, metalled roads. non-metalled roads, and one theme representing the drainage network of an area, etc.

Each theme has its own legend displayed in the Table of Contents. A theme's legend controls how the theme s displayed on the
view. You can edit the colours and svmbols of a theme.

Table of Contents
On the left side of the view's window is the Table of Contents which lists the themes in the view and controls the visibility of the

themes and drawing order. Each theme, has a check box on the left side. To display the theme, click the check box. The check mark
« appears in the check box and the theme is displayed.




When you are working with a view, you will see the view’s menus, buttons, and tools.

Working with Views in a Project
An ArcView project can contain any number of views.

* To see which views are in a project, click the Views button in the project window. The views in the project are shown in the list.

* To create a new view, with the Views button selected, click the New button at the top of the project window. A new empty
view will appear. ArcView names new views in numerical order: View1, View?2, View3, and so on.

* To open a view, double click the view’s name in the list of views in the Project window, or select the view’s name and click the
Open button.

* To close a view, choose Close from the File menu.

* To rename a view, click once on the view in the list in the Project window and choose Rename from the Project menu.

* To delete a view: click once on the view in the list in the Project window and choose Delete from the Project menu. To select
several views for deletion, hold down SHIFT and click the other views to delete.

* To save the work undertaken with a view, choose Save Project from the File menu or click the Save Project button in the View
button bar.

* To copy a view from one project to another, if you want to get a view that is in another project and put it into your current
project, you should import the other project into your current one using Import in the Project menu. This will copy all the
components of the other project into your project.
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Exercise 1

There should be an existing database for ArcView to work. For this lab exercise, you will use the Bagmati datasets on a scale of
1:250,000. The available ARC/INFO datasets of Bagmati Zone that you can practise with and incorporate into your projects are:
Outline, District Boundary, Elevation, Ecological Regions, Roads, River, National Parks and Protected Areas, Settlements, and Spot
Heights.

In this exercise, you will learn the following.

* How to create a project

* How to create themes

« How to edit a theme's legend

* How to classify spatial data

* How to move around the display
* How to carry out spatial analysis
*  How to select features

* How to carry out logical selection
* How to define themes

* How to edit a theme

Getting Started

Click the ArcView icon &l to start ArcView from the Microsoft Office Window.

Creating a Project

When you create a project, you create one file that contains the views, tables, charts, layouts, and scripts that make up the project.
To create a project, choose New Project from the File menu.

ArcView creates a new project called Untitled and opens the Project window.



Creating a Theme

You can create a theme, selecting the data source that you want it to represent. Any supported data that you have read access to
can be created in a view as a theme.

To create a theme of ARC/INFO coverages of the Bagmati dataset -

From the View menu choose Add Theme or click the Add Theme button to display the Add Theme dialog box.
In the Data Source Types box, choose Feature Data Source if it is not already selected,
Mavigate to the directory d:\gistm\ data\ bagmati where the ARC/INFO coverages of the Bagmati dataset are contained.

Jd\gistrn\data\bagmat

@ Direclories
) Libraries

Datn Sowrce Types: Drives:
| Feature Data Source [l] [d

Now double-click all the features one-by-one and press OK. ArcView will add the coverage to the view's Table of Contents
and choose the feature class for you.

To add all the ARC/INFO coverages into & view at once, select the coverages by holding down SHIFT and clicking on the
coverage, and then press OK.

When you create a theme, ArcView does nol immediately draw it on the view. This enables you to first edit the theme's legend or
change the drawing order. To draw the added theme, click on the check box next to the theme's name in the view’'s Table of
Contents.
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Now, to draw the roads of Bagmati, click on the Roads’ theme. The roads will be displayed in a view. You will notice that all the
roads are displayed in one colour, which indicates they are the same type of road. However, they are not. Five different types of

road are defined in this coverage. So, to display five different types of road in a view, you need to edit the legend of the theme
Roads.

Editing a Theme’s Legend

By editing a theme’s legend with the Legend Editor you can change the patterns and colours of the symbols that ArcView uses to
draw the theme in your view.

To edit the legend of Roads, first click once on the theme Roads in the Table of Contents to make it active. Then choose Edit
Legend from the Theme menu or double<click the theme Roads. ArcView will display the Legend Editor.




Theme: | Road Network ]
Field: [ Roads_id | Esave |
Symbols O Lebels & Valuss

N/

WAVEE:
| AN

VY,

In the Theme box, you will notice that Roads is selected, which is correct, and, in the Field box, None is selecied, which you have o
change. Click the 7 button in the right comer of the Field box. The items of the Roads’ coverage will be listed. Select the item

ROADS_ID according to which roads are categorised. Then you will see that the [D values and the cormesponding symbols are
displayed. Edit the ID values accordingly to 1,2.3,5.6.
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MNow, change the colour of the lines using the colour palette. To display the roads with the [D value 1 in red, double-click on a
symbol in the Legend Editor, The pen palette (figure) is displayed in which you can define the thickness of the line. To change the
colour, click once on the colour button. The colour palette is displayed, choose red. As soon as yvou choose red, you will notice that
the colour of the line in the symbol field of the Legend Editor has changed to red.




— | Color Polette |

El-l:'-. I:]
Cap: | Butt | |
Join. [Miter N

Similary, change the colour of the other individual lines as you desire.

After choosing the colours, the next step Is adding labels, You can enter your own text label next to each symbaol in the theme's
legend in the Table of Contents. This allows you to describe what each symbol represents. Press the Labels’ button on the Legend
Editor and enter the text you want to appear next to each symbol. Add the text lor each type ol road as follows.

Metalled Eoads
Non-metalled Roads

2

3

4 Pack Track
3 Local Tralls
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Thems: | Rond Metwork |i

Field: | Roads_id ]

Metalled Roads
Unmataliad Roads

Pack Track
Local Trails

AF=
ESavE
|EDEEED)
EEnEp
[EBandom)
|

Press Apply and your labels and colours will appear in the Table of Contents. Click the check box to display your results in a view.

Hiding a Theme's Legend

The legend of each theme in a view is normally shown in the view's Table of Contents. However, You can save space in the Table
of Contents by hiding legends. To hide a theme's legend, click on the legend to make the theme active, and then choose
Hide/Show Legend from the Theme menu,

Classifying Spatial Data

By specifying a range of symbols, you can symbolise and classify the features in a theme based on the values they have for any
field in the theme’s attribute table. You can change the classification and symbols of a theme with the Legend Editor.

To classify the features, the procedure is as follows.




* Inthe Legend Editor, choose the name of the field you wish to use to symbolise the theme.

*  Set the number of classes or type of classification you require by pressing the Classify button to set the classification to either
Quantile, Equal Interval, or Unique Value.

Classification

@ Quantile
C Equal Interval

O Unique Value - I
Number of ClasseE

To choose a random range of colours, the procedure is as follows.

* Press the Random button in the Legend Editor.

Up to now, you have created a theme for the Roads’ coverage. Similarly, create themes and edit the legends of other coverages.
Move Around the Display

* You can use the view bufton bar and tool bar to move around and zoom in on the display.

* Use this button to zoom to the full extent of all the themes in a view which allows you to see everything.

* Click on a theme in a view’s Table of Contents to make it active, and then click this button to zoom to the area covered by
the active theme.

*  When you have selected the features on a view, click this button to zoom to these features of the active themes of the view.,
*  Use this button "Efi”-"":' to zoom in on the centre of a view.
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Use this button I 1 to pan the view by dragging it in any direction at any time.

Performing Spatial Analysis

Spatial analysis operations provide the means to look for or determine relationships between themes, to assign the attribules of
another, and to perform aggregation of both features and attributes.

Spatial analysis operations available in ArcView include the following.

& & @& & & & @

Finding point features that are nearest 1o the selected point or line features

Finding pownt features according to the polygon features they fall inside (point-in-polygon)

Finding line features according to the polygon features they cross (intersection).

Finding polygon features according to the polygon features with which they coincide (intersection; polygon-in-polygon)
Finding features that are adjacent to the selected features

Creating new features by merging a set of adjacent features into one single feature or aggregate disjunct features
Selecting features by specifying a buffer distance

Selects the features of the active themes with the features of the theme you specify, Choose Select By Theme in the Theme menu.

To select a theme using another theme, follow this procedure.

1
F
3

4

ARy

. Make the themes to be selected active. Those are the target themes.,

In the Theme menu, choose Select by Theme.

. Choose the spatial relation type.

This phrase qualifies the selechion. ArcView provides several spatial relation types. The types you see depend on the selector
theme's feature type. In some cases, you may want to pick the selector theme before choosing the spatial relation type.

Pick the theme from which the features are used o make the selection.




This is the selector theme. ArcView selects features in the target themes using the selected features of the selector theme. If no
features in the selector theme are selected, ArcView uses all the selector theme's features to select.

5. If you choose Are Within Distance of, specify the selection distance.
ArcView selects the features in the target themes whose distance to any of the features in the selector theme is less than or
equal to the selection distance. The selection distance units are the distance units of the view. Set the distance units in the View
Properties dialog box.

6. Choose a selection method.
ArcView provides three selection methods. New Set creates a new set of selected features from all candidate features. Add to

Set adds new features to the existing selected set of features. Select from Set selects features only from candidates in the
currently selected set of features.

Notes

* Specifying a selection distance essentjally creates a buffer polygon around the features of the selector theme; however, the
buffer polygon is not visible.

» If you specify a selection distance of 0, ArcView selects the features that intersect the selector theme's features. A selection
distance of 0 selects all points in the target themes that fall within a polygon, all lines that intersect, and all lines that intersect
the selector theme's polygons and all polygons that intersect the selector theme's lines.

* ArcView uses the selected features of a theme to make the selection; therefore, if the active theme is the same theme as the
selector theme, and you choose Intersect, you can select features that are adjacent to the selected features.
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Example

To identify the Settlements that are within 1,000 Metres of the Roads

1. In this example, you are dealing with the distance. So, your first task is to set the map and distance units. To do this, choose
Properties from the View menu. Set the map units and distance units to metres and press OK

2 Activate the Settlernent in the view’s Table of Contents by clicking once, if it is not already activated.
3. Click the check box to display the settlements and roads.

4. Select Select by Theme from the Theme menu.

5. In the Select features of active themes box, select Are within Distance of.

6. In the Selected features of box, select Roads.

7. Select New set 1o exit from the Select by Theme menu and wait for a few seconds. ArcView will display the settlements within
1,000 metres of the roads in different colours {yellow).

You can check your results by measuring the distance of marked and unmarked settlement points from roads, Te do this,
1 elick the measurement B8l button,

2 select any yellow marked settlement point by clicking once, and

3. stretch the measurement cursor to the roads around it.

The distances will be displayed on the lower left hand cormer of the screen. Similarly, check for other points,




Selecting Features
Selecting leatures on a view enables you o

* find specilic geographic features that interest you or meet certain important criteria, and

*  work with specific geographic features in a variety of ways to find out more about them.

There are several ways to select festures on 8 view. You can select them according to thelr location, according to their attribute
values, or by selecting their records from a table. You can select features from one or more theme=. Before you can select features
from a theme. vou have to click on the theme in the Table of Contents to make it active.

Features highlights views when they are selected and they remain highlighted until a different selection is made, or until they are
deselected.

Selecting Features with the Mouse

The Select Feature tool allows you o select features with the mouse by pointing at them or by dragging a selection box over them
Features that fall partly or wholly inside the box you define will be selected.

2electing Features Using Shapes

Shapes, such as circles, boxes, ines, and polygons, drawn on a view using the Draw 100l can be used to select features. Simply
draw the shape and then press the Select Features Using Shape button.

Selecting a Feature Using Find

Find is a quick way to select a particular feature of interest. For example, if you are working with a theme of the settlements and
you want to select Koteswor, simply type the name into the Find dialog box,

Selecting Features Using a Query

Use a query when you want to select features according to their attribute values. For example, you can build a query to select all
the settlements in Bagmagi Zone with populations of mare than 10,000, You can also build more complex gueries.
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You can also use the Query Builder to narrow down your selection by building a query that only selects features from the set you
have already selected.

Example You Have a Theme Displaying the Point Locations of Seftlements, and Want to Find Out the Settlements within a 10,000 Metre
Radius of Kathmandu Municipality

In this case, you do the following.

1. Click on the settlement theme in the Table of Contents to make it active.

2. Use the Draw tovol to draw a circle with a 10,000 metre radius centered on the Kathmandu Municipality location.

3. Choose the Select Features using the Shape button to select the settlements in this area.

4 Chick the Query Builder button. ArcView displays the Query Builder. Build a query to select the settlements having a
population greater than 10.000.

5. Press the Select From Set button on the Query Builder, From the set of settlements that i< already selected. ArcView will select
those that match the query.

Selecting Features by Selecting Records in a Table

A theme's attribute table contains one record for each feature in the theme. When you open a theme's attribute table containing the
attributes of a theme's features, selecting records in the table automatically selects the features they represent on the view.

To select leatures by clicking on records in the theme's attribute table

1. Click on the theme in the Table of Contents to make it active, if it is not already.

2. From the Theme menu choose Table or click the Open Theme Table button. ArcView displays the theme's attribute table.

3. Hold down SHIFT and click on the records you want to select. The features in the theme represented by these records are also
selected in the view (You can also use the keyboard to select records in the theme's attribute table.)

Selecting Features Using 2 Chart

A chart created from a theme's attribute table containg one data marker for each selected feature in the view. By erasing dala
markers in the chart, you can deselect features on the view. In this way, you can use the chart to focus on particular features of
interest.

pa—“. _#



Logical Selection: The Query Builder

The Query Builder allows you to select features on a view and records in a table by defining a query based on their atfribute
values.

Building a Query

To build a query, choose a Field, then an Operator, and then a Value. You build a query by double-clicking on these options with
the mouse or by typing your query directly into the query text box. By default, the query is contained within parentheses.
However, parentheses may not be required, depending on the complexity of your query. If the Update Values choice is on, click
once on a field name to list its values in the Values’ list. Field names are always enclosed in square brackets ([ ]). If the value you
want to use in the query is not in the Values’ list, type it into the query text box.

Example
1. To select elevation zones between the range of 1,500 - 2,500 metres, you can use the query (Note: Item GRID_CODE represents

the elevation value).
([GRID_CODE] >= 1500) and ([GRID_CODE] <= 2500)

To do this:

a. click the theme RELIEF to activate it,
. select the Query Builder button (fig) OR select Query from the Theme menu,
¢. to build the query, choose the field (GRID_CODE), then an operator (>=), then a value (1500), again an operator (and), then
the field (GRID_CODE), then an operator (<=), then a value (2500), and
d. select New Set.

AgcView will display the zones that match the criteria,

2. Strings, such as names, are always quoted in queries. Strings are case insensitive, so you can select the VDC Bidur with:
{ [VDCNAME] = "BIDUR" )

3. Use * as a multiple character wildcard. For example, to select Ramche you could use the query:
([VDCNAME] = "RAM*™" }
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4. Use 7 ina string as a single character wildeard. For example, to find Salyankot and Methinkot, use
{ [VDCNAME] ="177777kot” )

5. To select all the VDCs with names starting with the letters D, you could use:
( [VDCNAME] > "I )

Defining a Feature Selection for a Theme

By default a theme represents all the features of a particular feature class i its data source. However, it is useful to be able to
restrict a theme to represent only a subset of the features in a particular festure class.

For example, you might have a data source that contains arcs for all the roads in your study area, but you want to create a theme
that only represents the major highways. In this case, you would first add the theme to your view and then edit its theme

properties to define a feature selection consisting of the major highways.

By defining a feature selection you can control exactly which features from a theme's data source are represented in the theme.
Features are selected based on the attribute values tn the theme's attribute table, The feature selection is defined as a query in the

Query Builder accessed from the Themw Propertivs dialog boox,
To define a feature selection for a theme:

click on the theme in the Table of Contents to make it active,

from the Theme menu, choose Properties or click the Theme Properties button - the Theme Properties dizlog boe will be
choose the Definiton category of properties U this has not already been chosen,

press the Query Builder button. ArcView displays the Query Builder,

build a query,

press OK on the Query Builder - your query appears in the Theme Properties definition box, and

press OK on the Theme Properties dialog box.

Arc View will select the features that match the query and redraw the view. Only those features that are selected in the query are
now in the theme.

A 2 e




Example

The theme NAT_PARK actually represents National Parks. The title itself may not be clear to all. Define the theme NAT_PARK as
National Parks to make it more clear.

1. Click the theme NAT_PARK to activate it, if not already activated.
2. Select Properties from the Theme menu.
3. Type National Parks in the Theme Name box and press OK.
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Chapter 2

TABLES: Attributes of Spatial Data

What is a Table ?

A table lets you work with data from various tabular data sources in ArcView, In fact, with ArcView's tables you can access almost
any tabular data resource in your organisation and work with it spatially!

* You can display, query, and analyse data in tables. You can highlight records in tables by selecting geographic leatures
displayed on views, and vice versa.

* You can display tables on a view to reveal the geography of your data,

*  You can easily create charts from tables to visualise trends, patterns, and distributions.
Warking with Tables in ArcView

An ArcView project can contain any number of tables.

To See wiich Tables Are tn o Project

Click on the Tables” icon in the Project window. The tables in the project are shown in the list

To Open a Table

Double-click the table’s name in the list of tables in the Project window, or select the table's name and click the Open button,

To Open & Theme's Attriluile Tabile

1. Open the view containing the theme.
2 Click on the theme o make it active.
3. Choose Table from the Theme menu or click the Open Theme Table button in the View button bar,

E——




When you open a theme's attribute table, it will appear in the list of tables in the Project window, [t can also be opened using the
Open button on the Project window, as described above.

To Add » Table inte a Project
Use Add Table in the Project menu to open a dBASE, INFO, or delimited text file as a table in your project.

You can add an INFO, dBASE 11, dBASE IV file, or a tab-delimited or comma-delimited text file to create an ArcView table in the
current project.

Adding Tabular Data

To add an INFO, dBASE, or text file:

1. open a project or make the Project window active for the open project.

2 from the Project menu, choose Add Table,

3. in the List Files of Type box, choose INFO, dBASE, or Delimted Text,

4 navigate to the directory that contains the file you want to add, and

5.  doubleclick the file you want 1o add or choose the file and press OK.

ArcView creates a table named after the file you selected.

Creating a New Table

You may want to create a new table in ArcView and then add data o it

Creafe @ New Table in Your Project

On the Project window, select the Tables' icon and then press the New button, Enter a name and a disk location for the dBASE file
that ArcView will create {o store the source data for the table. A new table will appear in your project. ArcView names new tables
in numerical order: Tablel, Table2, Table3, etc.

Add Fields to the Table

On the Table menu bar, select the Add Field choice from the Edit menu. The Field Definition dialog box will appear allowing you
to define the field in the table.
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Add Reconds to the Table

On the Table menu bar, select the Add Record choice from the Edit menu. This will add a single record to the table. Repeat this
action as many fimes as needed.

Add Data to the Table

On the Table tool bar, select the Edit tool. This allows you 1o edit the empty cells in the table.
Adding and Deleting Records

To Add a Record

In the Edit menu, choose Add Record.
If you add a record, use the Edit tool to update the values for the new record.

To Delete a Record

In the Edit menu, choose Delete Record. You must select one record before this choice becomes active.

Editing Records in a Table

By default, you are not allowed to edit a table. ArcView shows this by displaying the field names in the table in italics.

Omly tables based on dBASE or INFO files on disk may be edited. Tables that have been created by connecting them 10 o database
mﬁiﬁmﬁm\fhw does not commit changes back to database servers. You cannot edit tables created from

If you have the write permission to the data file on which the active table is based, and you wish to edit it, you can choose Start
Editing,

1f you do not have the write permission to the data file, Start Editing will be unavailable.

All editing, except for deleting fields and records, are immediately written to the source data file. To finish editing (and/or commit

— P \ :



Calculating Field Values

You can use the Calculate dialog box to calculate the value of the active number, string, date, or boolean field.

The value is the result of an expression that you enter into the text input area of the dialog box. The calculation applies to the
selected set of records. If no records are selected, the calculation applies to all records. You can enter the expression by double-
clicking on field names and requests or you can type the expression yourseif.

In its simplest form, an expression can just be a number, a string, a date, or a boolean value. For example, to set the value of a
string field named [Zoning] to the string "Industrial”, type the siring enclosed in double quotes in the text input area of the dialog

box. To set the value of a number field to the number 143, type the number in the text input area of the dialog box.

In addition, an expression may consist of any combination of field names, enclosed in square brackets, and valid Avenue requests
that can be made on the class type of the field. The result of the expression must be a single object or value.

Sorting Records

Sorts a table on the active field. Click on a field name in a table to make it active and then choose Sort Ascending or Sort
Descending.

Table Menu Bar

Sort Ascending and Sort Descending in the Field menu
Table Button Bar

Ascending Order

Using the active field, this control puts the record with the value at the beginning of the alphabet, the earliest date, or the lowest
number, at the top of the table.

Descending Order

Using the active field, this control puts the record with the value at the end of the alphabet, the latest date, or the highest number,
at the top of the table.
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Examples

To Sort a Table

1. Click on the name of the field you wish to sort on to make it active. The name of the field will be highlighted.
2  Choose Sort Ascending or Sort Descending from the Table menu or the Table button bar.

Sorting always occurs an all the records in a table. If you want to sort the selected records, sort the table and then use Promote,
Promote will display the selected records at the top of the table, in the order in which they occurred in the sorted table.

When vou close a table, close the project that contains it, or export a table. Any reordering of records that you have carried out by
sorting or promoting is not saved. The next time you open the tabie, the records will be in their original order.

Joining Tables

Joining tables enables you to attach your tabular data to the themes in a view so that you can display. dentify, query, summarise,
and analyse your dota spatially.

You have a dBASE file contalning population data for all the districts in Bagmati Zone. To display this data in a view:

add the dBASE file into ArcView as a new table,

open the attribute table of a theme representing the districts,

use the Join control bo join the new table to the theme's attribute table, and
edit the theme's legend to specify which data will be displayed.

o L

Remove Joins

To remove joined fields from a destination table, use Remove All Joins from the Table menu




In this exercise, you will calculate the population density and population growth rate of each district of Bagmati Zone using the
census data from 1981 and 1991.

Add New Fields POP_91, POP_g81, DENSITY, GRW_RATE in the Theme District.

For this exercise, your first task is o add the fields representing the population in 1981 and 1991, growth rate, and population
density of each district. To do this,

click on the theme District to make it active, if it is not already active,

choose Table [rom the Theme menu or click Open Theme button in the view bulton bar,

use Start Editing from the Table menu,

choose Add Field from the Edit menu,

type POP_91 in the Name box, select Number in Type box, type 10 in Width box, and type 0 in Decimal Places box, and
similary, add felds POP_B1 (number, 10, 0), DENSITY (number, &, 2), and GRW_RATE (numdber, 4, 2),

& & & & & ®

Field Definition

] Density

Number
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Add Records

Add records for POP_91 and POP_81 for each district as shown.

District Name
Sindhupalchok
Kavre

Lalitpur
Kathmandu
Bhaktapur
Nuwakot
Dhading

Rasuwa

To do this,

use Start Editing from the Table menu,
in the Edit menu, choose Add Record,

POP_B1

232326
307150
184341
422237
159767
202976
243401

30241

select Edit tool button ™ to update the values in cell, and

add the values for POP_91 and POP_81.

Calculate Values

Open the attribute table for District by selecting Table from the Theme menu.

The Field Calculator menu appears. Define the formula for density {pop_91/area_sq) in this menu.

Use Start Editing from the Table menu.

In the table, activate the field DENSITY by clicking on it.

Use Calculate from the Field menu.

Select area_sq (area in square kilometres) from the fields.

Select division operator (/) from the Requests box.
Select pop_91 from the Fields’ box.

POP_91
261025
324329
257086
675341
172952
245260
278068

36744




* To calculate density, activate the DENSITY field by clicking on it.
* Define the formula ([pop_91/pop_81 - 1]* 100) in the Field menu.

*  Press OK to sea both the results.

B985 17753154400

140033 | 182600

129502 | 254200 !

122729 1121.00

| 39500

164545 | 1356.00
86134 11900

126760 | 385.00

3950000

=2
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Fiald Calculator

Typa
® Number

© String

O Date

2.150000

£61025

1,420000

245250

122729

§75341

2,080000

324025 |

324323

5.880000

164545

0.560000

172852

86134/ 11900 159767

0830000 _

257086

126760 | 36500 184341

3,950000




View Statistics

Now, you may want to view the statistics of fields that you have just calculated. To view the statistics of Density,
* open the attributes table for District,

* activale the field Denaity by clicking once on it. and

= select Statistics from the Field menu.

This will give the statistics of the field Density as shown.

Sialishes tor Denzity Geld

—_

Standard Deviation: 1.71
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Chapter 3

Example 1

CHARTS: Visualising and Querying Data

What Is a chart ?

A chart is a graphic presentation of tabular data that provides a powerful additional visual representation of the attributes
associated with geographic features. You can use a chart to display, compare, and query your geographic and tabular data
effectively. Charts are fully integrated into ArcView's geographic user interface.

A chart references tabular data in an existing ArcView table in your project and defines how it will be displayed. A chart is
dynamic, because it reflects the current status of the data in the table. If there is a change in the source data on which the table is

based, this change will automatically be reflected in both the table and the chart the next time you open the project file that
contains them. If you edit the table in ArcView, the chart will immediately reflect the editing.

Create a Chart to View the Population in the 1981 and 1991 Census of Each District of Bagmati Zone.

To create a chart:

1. click on the table for District to make it active and open it,

2. choose Chart from the Table menu or the Create Chart button on the button bar to open the Chart Properties dialog box,
3. inthe Pick a Table window, choose the attributes of District boundary table,

4. in the Chart Properties dialog box, select the fields {pop_81 and pop_91) that you want to plot on the chart and the field you
want to use to label the data series, and

5. if desired, modify the data plotted on the chart and the look of the chart.




Populibon F Y vergas 195

Chart Propames

Nama| Population 1981 versus 1991 |
Table| pat bt |
Fields Groups: 600000 + Bpastwa
Pop_91 -
Male_91 (. | Pop 81 500000 | DHADING
Female_91 B SINDHUPALCHOK
&) P
Area_s | EEETE S ENUWAKOT
— 100000 B EATHMANDI
Label series using: = B EAVEE
| District
= o il B RHAKTAPUR
Comments: - ¥
L0000 LALITPUR
0
Pop_81 Pop 91
Ik

Chart Types

ArcView provides six types of chart - area, bar, column, line, pie, and xy scatter- to appropriately display different kinds of
information. Each chart type has several variations on the basic type to select from such as adding gridlines or exploding the first
pie slics. Some charts are good for comparing values and representing trends and others are best for emphasising a significant
element. Choosing a suitable chart format for your data allows you to present your information more effectively.

Press the buttons for the type of charts you want to create.

Area Bar Column Line Pis  Scarbered
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Example:

Create a Graph to Show the Trend in Population Growth Rate by District, 1981 - 1991.

Population Growth Rate by Districl 1991 -

Population Growth Rate by Distnet, 1991

QD e b L L e Dy

Growth Rate

B pAsUwA

B DHADING

B S INDHUPALCHOK
B NUWAKOT

B EATHMANDU

B AVEE

B RHAKTAPUR

B ALITPUR




Chapter 4

LAYOUTS: Producing Maps
What is a layout ?

A layout is a map that allows you to display views, charts, tables, imported graphics, and graphic primitives. The layout is used to
prepare these graphics for output from ArcView.

A layout defines what data will be used for output and how they will be displayed. A layout can be dynamic because it allows you
to make specific graphics live. When a graphic is live, it reflects the current status of the data. For example, if the data in a view
changes, the layout automatically reflects the change.

In this chapter, you will learn how to:

* work with layouts in a project,

* set up the page,

* add frames,

* add scale bars and north arrows, and
* add graphics and text.

Working with Layouts in a Project

An ArcView project can contain any number of layouts.

To See which Layouts Are in a Project

Click on the Layouts icon in the Project window. The layouts in the current project are shown in the list.

To Create a New Layout

With the Layouts’ icon selected, click the New button at the top of the Project window. ArcView creates a new layout and its name

will appear in the list of layouts in the project. ArcView names new layouts in numerical order: Layoutl, Layout2, Layout3, etc. See
the Overview for creating a layout. You can also double click the Layouts’ icon to create a new layout.
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To Open a Layout
Double click the layout’s name in the list of layouts in the Project window, or select the layout's name and click the Open button.
T Close & Layoul!

From the File menu, choose Close, or click the close option on the layout's window (This option varies according 10 the GUT you
are using).

To Remame a Layoul!

Click once on the layout in the list in the Project window and choose Rename from the Project menu. A layout's name is also a
layout property you can edit.

To Save the Work You Do wath a Layout

In ArcView, you save the work you do with any project companent by saving the project. To save your project, choose Save Project
from the File menu or click the Save Project button in the Lavout button bar.

To Copy a Layout from One Project to Another
If you want to copy a layout from another project into your cusrent project. you should mmport the other project into your current

ome using Import in the Project menu. This will copy all the components of the other project into your current progect. You can then
delete the components that you do not require using Delete from the Project menu.

Defining the Layout Page

When you want o create a map using a lavout, you will need to define some characteristics of the layout page. These include page
size, page units, orientation, and margins.

Page size

There are a nutmber of large and small format sizes provided by the default in ArcView. If you need a size other than these, you
can use A custom page size and define its width and height. The default page size is derived from your printer

|



Page units
Select page units from a list of choices. The default page units are inches.
Orientation

Choose between landscape and portrait orientation for the layout page. The default orientation is derived from your printer. If you
change the orientation, any new layouts will use the new orientation as the default.

Margins
Define margins for the page or use your printer's default margins. The default margins for UNIX are .25 inches. The default
margins on Windows and Macintosh are at the border of the page (0 inches), this value may change depending on your default
printer.

Qutput resolution

Define the resolution the Jayout is printed and exported at.
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Exercise: In this Exercise, You will create a Layout Map of Ecological Regions of the Bagmati Zone as shown below.

Ecological Regions

A
B ubs ks v sl
Bl onbess L

Celingas Lavail
Bub Top el Lo

T bl Lawm|

[ swnpn
CrgBumsa Anis
Tilghsi By

A

Note: Belore you proceed, make sure to set up the map units and the distance units of the view to metres as described in chapter 1

of this manual




Create 3 New Layout

*  Click the new button at the top of the Project window

* ArcView creates a new layout

Set-up Page

When you want to create a map using 2 layout, you will need to define some characteristics of the layout page. These include page
sire, page units, orientation, and margins.

Select Page Set-up from the Layout merm.
* Set up the page size = Letter 85 x 110 inches, page units = inches, width = 11, height = 85, orlentation = landscape, and
margins (top/bottom = 0.17; left/ right = 0.2).

T
Fage Hire: E‘_lj..!.ﬂ!,l!._-
Uratn: [ Tnabers |

widn: [T ] Hewwe (B8]

]

Margmy [ Lee prestes wordey
tou [Ri70355]  tan (iEH )
e [ 170000 | Peget [TFE |
Ceutjaiih Memerlulinn | Hormnd |

E—— & |
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Define Layout Properties
Before creating the layout, it is a good idea to define the layout that you are going to create.

* Select Properties from the Layout menu. The Layout Properties’ window appears.
* Since you are going to create a map of the Ecological Regions, type Ecologicel Regions in the Name box and press OK.

[

Gieid Spacing. Horzontat (035 | in
| veriest [§5

Eaap W0 Gnd [ |

Add View

*  Make sure that the theme Ecological Regions is displayed in the view.,
* Nuw,h:ui:l'ﬂﬂiﬁlwhﬂn]mm'mllj'nul.dkkﬂuﬂmhnthm..ﬂudupeufﬂunmrhmmhmﬂﬂsm:mrm
define the area (make a box) to be plotied in the view in your new layout. After you define the area, the view frame properties”

window appears

=

£ Live Link
O Prewera View Goale

[Pesawinios TN
mOa |pesE

*  Select Bagmati 1:250,000 (the name of your project) from the View box and press OFK. The map is displayed in your layout.




Add Legends

Layoutil

* Select the legend button B by clicking the view R button.
* Define the legend area {making a box) in the layout. Legend Frame Properties appears.

Legend Frome Properties

View Frame| {Emp |
ViewFrame |: Bagmati 12450,

Display: [ When Aclive )

| Presentation |i

* Select the ViewFramel: Bagmati 1:250,000 from the View Frame box and press OK. The legends are displayed in your layout.
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Add Scale Bar

»  Select the the scale bar button B
*  Define the area for the scale bar in your layout. The Scale Bar Properties’ window appears.

VieswFramal: Bagmatl 1:250

Shle | me——

Units: | meters ]
Interved [(1BO0D |
intwrvals: [2 i

aft Drvisions: | 2 =

Select ViewFramel Bagmati 1:250,000 from the View Frame box.

Press OK.
Add North Arrow
*  Select the North Arrow button [

* Define the area for North Arrow in your layout. The North Arrow Manager window appears.
=  Choose a symbol for north arrow by clicking on it and then press OK.

The Units and Interval box should be automatically calculated if the map units and the distance units are set up propesly.




Add Text (Titles and sub-titles)

*  Toadd a text for the title of the map, click the text button m
Move and click the cursor where you want to place your title. The Text Properties’ window appears,

Ao onial Adigemast m
Vartical Spacng [l 10 Jlines
Rotanon Angle: [T | degrees

|L_ox—3] Foancely)
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*  Type text Ecological Regions as the title of your map. Repeal the same process 1o add other text

. anuimymrmghﬂﬁummrbuﬂm-ulddrkmhmAhﬂ:lppunummdthEMLﬂwnrﬂiuﬂubnmm
resize your text.

. Tumuvf'_r,.rmuh:tmln}ruﬂwulmmhulyﬂurhrnuL:H:kmituh‘Hu.hlmllm'lﬂuhmhrdrlggi.n;ﬂ.

Now your final map layout should look like this.

Ecological Regions

By sl Fowna

[ Dutline Boundary
Eooiagical Zones

vl Laww|
Alpine Laval
Eub-apng Lol
MWontans Leve|
B colirean Leve

Bub Topinsl Lewsl
Topoal Lewal
[ stpee

] cuktkmtad s
B et Boady

BOG L 19080 MO0 eatany @
e




Printing

Finally to print your map layout, select Print from the File menu.

Note: Before using Print, you may have to use the Print Setup to configure your printer, if it is not already configured.
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Clossary

Adjacency
Describes whether two areas (polygons) share a common side. Some GIS store all the adjacency relationships for all polygons.

AM/FM
Automated Mapping and Facilities Management. Term used to describe the digital mapping systems used in utilities such as water
or electricity supply companies.

Analogue maps
Maps in paper form.

ASCII
American Standard Code for Information Interchange: a widely used industry-standard code which represents alphanumeric
characters in a computer.

Attribute
Non-spatial descriptive characteristic of a real-world phenomenon. Often a measurement or value associated with spatial
locations.

Bit
Binary digit. The smallest unit of informaticn representation within a computer which can be set to 0 or 1. Seven bits have 128
different combinations and can be used to represent alphanumeric characters.

Boolean aigebra

A method of specifying set combination operations: OR, AND, NOT, XOR. In GIS the sets are composed of geometry and the
operations specify how the geometry should be combined.

Buffer

A corridor of a specified width defined parallel to lines or around polygons. Buffering is the process of defining the corridor and
drawing the new geometry to delimit it.

CAD
Computer Aided Design: computer systems for drawing design graphics.

Glossary
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CcCD
Charge Coupled Device: a device used in scanners to sense light/dark or colour contrast on a scanned map.

Choropleth
Map shaded by a density according to value.

Connectivity
Describes whether sets of points (nodes) or lines are connected to each other.

Coordinate pair (X, Y) :
A pair of coordinates describing the location of a point feature on x and y axes. Sets of coordinate pairs are used to define lines and

polygons.

Coordinate system
A particular type of reference frame, often grid-based, that uses linear or angular quantities to designate the position of points
within the frame of reference.

Coverage
A collection of data describing spatial features stored in the same map file (primarily used by ESRI in ARC/INFO systems).

CPU
Central Processing Unit: the part of the computer that controls the flow of data and performs the computations.

CRT
Cathode Ray Tube: similar to a television picture tube, on which an image is displayed.

Cursor
The hand-held, movable part of a digitiser with cross hairs in a small window used for the accurate designation of points on an
image or map.

Database
An organised, integrated collection of data related by a common fact or purpose.




Database Management System ([DBMS)
A collection of computer software for organising and accessing the information in a database,

Diata capture
The encoding of data or the conversion of map data to digital data, both spatial and non-spatial aspects.

Data dictionary
This contains information about definition, structure and usage of data in a database. No data is actually held here.

Data model

An abstraction of the real world which incorporates only those properties thought to be relevant to the application in hand. Also, a
set of guidelines for the representation and logical organisation of data in a database, consisting of named logical units of data and
the relationships between them. In GIS, this term usually refers to a set of spatial features with associated characteristics.

Data quality
The quality of the data measured in relation to the actual phenomenon measured at source.

Dataset
A named collection of logically related features arranged in a prescribed format.

Data structure
Detailed and low-level descriptions of spatial storage structures and the operations possible upon them.

DEM
Digital Elevation Model: a digital representation of a surface as a regular grid of elevation values.

Digital map data
A collection of digital information about real-world spatial phenomena.

DT™M
Dhgital Terrain Model: a digital representation of ground surface relief enhanced by the addition of topographic information.

Digitiser
A device (usually electronic) for coding point locations on s graphic image or map to plane (x, y) coordinates,
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DOS
Disk Operating System: the software which controls the transfer of data between main memory and disk. MS-DOS™ is the most
common form of operating system for personal computers.

Edge matching
The comparison and adjustment of features to obtain agreement along the edges of adjoining maps.

Editing
Inserting, deleting and changing geometry and attributes to correct and/or update a model or database.

Electro-magnetic spectrum
The spectrum of wavelengths of electromagnetic radiation {including infrared, visible, and ultraviolet light).

Electrostatic printer/plotter
A device for printing graphic images by placing a grid of small electrical charges on the paper so that a dark or coloured powder,
or toner, will adhere to these places.

Entity
A real-world phenomenon perceived or perceivable by human agency.

Error
Various forms of discrepancy between real-world phenomena and a database. Error can be introduced into a spatial database
during capture and processing.

Feature
A real-world phenomenon, named and classified. Often used in cartography to name classes of elements shown on a map.

Feature code
An attribute specifying the type of feature recorded in a GIS. Cartographic agencies define feature codes to standardise the
description.

Field
A subdivision of a record which contains a unit of information. A characteristic measure for ail records.



File
A collection of records, each of which can be referenced according to its position in the file.

Filtering
A method of changing the level of detail or extraction of information from a spatial (normally raster) dataset.

Generalise
Reduce in detail, simplify or resample to change the level of information in a dataset. The most common generalisation operation
is line-thinning by discarding coordinates.

Geographic information
Information which can be related to a location (defined in terms of point, line, and area), particularly, information on natural
phenomena, cultural or human resources.

Geographical Information System (GIS)
* a set of tools for collecting, storing, retrieving at will, transforming and displaying spatial data from the real world for a
particular set of circumstances (Burrough 1986)

Geometry
A system for the manipulation of points and lines defined by a set of axioms.

Global Positioning System (GPS)
A GPS is a position-fixing system which uses the time taken for signals to travel from at least three GPS satellites in a known orbit
to a receiver on the ground.

Hardware
The physical device used to process a computer programme and display the results.

Heads-up digitising
Heads-up digitising systems automatically convert strips of raster pixels to vector data by tracing them on screen

Glessary
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Image processing

Encompasses all the various operations that can be applied to image or raster format data. These include image compression,
restoration, enhancement, rectification, preprocessing, quantisation, spatial filtering and other image pattern recognition
techniques.

Ink-jet printer/plotter
A display device that prints out characters and grey tones as patterns of small dots formed by tiny drops of ink sprayed onto the
plotting medium.

Interactive
Describes a process of two-way communication between the user and the computer.

Interface
An electronic translator of the signals of two devices, such as a computer and a plotter, so that otherwise incompatible information
can be transferred between them; or a screen format for the display and communication of commands to the computer.

Interpolation
The procedure for estimating the values of unknown points on a surface from the values of a number of points of known value.

Isoline
A line joining points of equal value.

Isometric models
A model of a scene or object scaled to reality.

KBS
Knowledge Based System: a system based upon rules, defined and structured for use in making inferences in restricted knowledge
domains.

LAN
Local Area Network: a network linking computers together in a small area (usually a single building).



Layer
Uswally represents a theme or feature type within a database. Layers which are registered to the same coordinates as other layers

can be integrated in different ways to create a new layer,

Line
The shortest distance between two points (somebmes called a line segment), In some GIS, many connected line segments are also
relerted tooas a line. A one-dimensional object.

LIS
Land Information System: a system for handling land ownership {cadastral) data.

Map algebra
A set of operations for manipulating, filtenng, and combining raster maps devised by Tomlin and used in many GIS.

Map projection
A transformation from a spheroid to a flat plane representing the parallels of latitude and the meridians of longitude of the earth.

Menu

A list of available options displayed on a terminal or a set of preprogrammed areas on o digitiser.

Mouse
A devicr used to move a screen cursor and o input commands; commonly used in graphical operations.

Network analysis
Analytical techniques concerned with the relationships between locations on a network, capacibes of network systems and the best
location for facilities on a network

Object-oriented programming

Object-onented  programming 5 a language design which has been used o develop database management systems and
application programmes such as GIS Object-oriented software has data 'encapsulated’ with operations, and commands are
executed using message passing.
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The process of integrating digital representations of various spatial data registered 10 a common coordinate system.

Pixel

Short for Picture Element, Le., the smallest discrete element that makes up an image. It may represent either a small square or
portion of the earth’s surface, scanned by satellite or aiscraft, 8 portion of a graphics Image sensed by an optical scanner or an
individual dot on a screen.

Point
The position or location of an object in a spatial reference system. A zero-dimensional object.

Polygon
An area with three or more sides intersecting al the same number of points. A two-dimensional object.

P'rojection
The procedure for ransferring features from the spherical sarth to a flat plane using mathematical transformations.

Quadtree
A structure to compress and spatially index raster data. Constructed by dividing an (square) area ol data recarsively unhl a

quadrant is completely full or empty.

Query
A structured enquiry made on a map or database using formal language.

Raster data

Data expressed as an array of pixels with the spatial position implicit in the ordering of the pixels.
Rasterisation

The process of converting vector data into raster form,

Record
A set of observations on real-world phenomena as described by attributes.



Relational database
A database of tables which can be linked together through common attributes.

Remote sensing
The technique of obtaining data about the environment and surface of the earth from a distance, e.g., from an aircraft or satellite.

Resolution
Level of discrimination in the representation of objects, generally spatial.

Scale
The ratio or fraction between the distance on a map, chart or photograph and the corresponding distance on the surface of the
earth.

Scanner
The electronic device used to convert analogue information from maps or images into a digital format usable by a computer.

Scanning
A method of data capture whereby an image or map is automatically registered and converted into digital raster form.

Sliver polygon
Formed when two polygons which have been overlaid do not abut exactly but overlap along one edge and leave a small space
between the two.

Software
A system of programumes used to execute tasks written for the computer.

Spatial analysis
Analytical techniques associated with the study of locations of geographical phenomena together with their spatial dimensions.

Spatial data
Data relating to the location of geographical phenomena together with their spatial dimensions.
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SQL
Structured Query Language: a language for the manipulation, update and querying of the data in relational database tables. ISO
standard 9075 (1987).

Standards
A fixed quantity or quality, applied to data. Standards serve as a reference or rule and establish practices or procedures to evaluate
results.

Terrain modelling
The creation of a realistic terrain representation for computer display.

Tessellation
The subdivision of geographic space using either regular or non-regular methods.

Thiessen polygon
A polygon bounding the region closer to a point than to any other adjacent point.

Tile
A regular- or irregular-shaped spatial unit within a geographical database.

TIN
Triangular Irregular Network: the most equilateral set of triangles possible joining a set of points.

Topographic map
A map showing the features which describe the surface of a particular place or region.

Topological structuring
The process of organising data so that the relationships of connectivity, adjacency and containment are encoded and stored.

Topology
The location of geographic phenomena relative to each other but independent of distance or direction. Includes relationships of
connectivity, adjacency, and contairument.




Transformation
Mathematical conversion of coordinates between alternative referencing systems. Affine transformations keep straight lines
straight, and curvilinear ones may make straight lines curved (e.g. as in map projection).

Triangulation
The interconnection of ali points within an area to form a set of reproducible triangles.

UNIX
An operating system of software used commonly for workstations.

Variable
A discrete measurement on a parameter.

vDU
Visual Display Unit: a screen display for a computer.

Vector data
A description of spatial phenomena based upon geometry.

Vectorisation
The process of converting raster data into vector form.

Window
A frame with a specified size and location on the screen of an interactive graphics system and within which a rectangular portion
of the 'map’ is displayed.

Work station
A powerful computer with integral processing and data storage and a high resolution screen.
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Appendix A

Arcview = The Litimate wWindow to Spatial Data
Environmental Systems Research Institute, Inc. ARC News,
Reprint, Spring 1991 Issue, Vol. 13, No.2 [Reference/Reprint]

The benefits of using GIS are now widely understood by most organisations that use spatial information. Despite this awareness,
the actual number of active users has remained relatively small. This is due in part to the fact that virtually all GIS technology
currently available (from desktop to mainframes) requires, at least, basic GIS skills.

This is about to change. This month ESRI is intrgducing a completely new product called ArcView which provides a major
breakthrough in the usability of GIS. ArcView creates a new user environment for geoprocessing by making it easy and fun for
users to visualise, query, and analyse geographic information.

ArcView is an easy-to-use productivity tool derived from years of research and development efforts by ESRI that have gone into
producing its ARC/INFO software. It is inexpensive and completely compatible with all the various types of data supported by
ARC/INFO. These include vector coverages, tabular database management systems, surface models, grids, and a variety of raster
images, including remote-sensing data and binary-scanned documents.

“ArcView will revolutionise the way we think about bot}t mapping and GIS,” said Jack Dangermond, ESRI president. “People who are not
familiar with GIS can sit down and use 1t right away with virtually no training. The software is based on simple ideas that allow users to learn
to use it naturally and intuitively. They can learn siniply by experimentation and be thoroughly competent in a matter of minutes to hours.”
This will open up GIS to a whole new category of users, including managers, elected officials, students, the public, and a vast array
of others who are not trained in GIS, but who have an interest in and use for geographic information.
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*ArcView is not just GIS made simpler,” continued Dangermond. "It alse introduces many new concepls for inberacting with an electromic
model of spatial reality. ArcView includes a vanety of highly mierrelated msualisation and guery tools that can be used to craft a liternlly
ettdless number of interprelations and view of geography. These vietws can by produced as soff copy publicabions for acoess across @ metwork or
oulpul directly as hard copy with o variety of deskiop-related devices. With the inbroduction of ArcView, GIS (s moving from o tool to create

applications to & front-end view of applications.”

Although the biggest impact of ArcView will be in making geographic information more accessible and usable lo a wider range of
potential users, ArcView was onginally conceived of as a way to help ESRI's existing user community. This is where the new
product will perhaps have its largest initial popularnity. Both PC ARC/INFO and workstation ARC/INFO users will instantly be
able to publish their data for casual query and display.

will also be able to integrate ArcView into their application systems, allowing ArcView to function as the display and

e View will qwﬂﬂdﬂwﬁhcﬂumwgwm

revelulionise the way “The original idea for ArcView came from our existing users,” explains Dangermond. “We learned that may of them needed a

wie Hunk aboul Bolh

& way o provide electronic access to their data for people who needed to socess it but could not afford the time o learn a
g Ang Gl complicated technology. Their option historically was to develop a custom application. With ArcView, the most valuable GIS
concepts of ARC/INFO software are organised into a generic system that can serve virtually every user.”

ArcView will run on PCs, Macintosh, and any al the UNIX platforms now supported by ARC/INFO. It operates as a stand-
alone desktop mapping solution as well as in the role of a client on a client-server network.

As a stand-alone application, ArcView can be used by existing ARC/INFO users to provide copies of their data to other
individuals and organisations. There are thousands of ARC/INFO users who have created tens of thousands of coverages around
the world. ArcView will create an environment that promotes the publishing and sharmng of their data.




The publishing environment will also take place across electronic networks. On a network, ArcView can be running on a user’s
existing desktop computer and be accessing and visualising ARC/INFO databames across the network without converting or
transporting any data, In this sense, ArcView serves as an integrating technology bringing together all of the diverse desktop units
into @ shared GIS network.

Applications

ArcView will open up computerised mapping to a whole new world of users. Because it is so simple to use. ESRI envisions that
ArcView will appeal to the following types of people.

o @ ® ® ® @& & & @

Specialists who only occasionally need to access geographic information and, therefore, do not have the time or the inclination

to learn to use a comprehensive GIS

ARC/INFO users who are using ARC/INFO for analysis and would like to use ArcView for quick and easy display and query

Individuals who want a single desktop GIS that is totally integrated with a database

ARC/INFO users who want to make data available to other departments, feld offices, or other remote locations

Private and public organisations that want to publish their data electronically for others to examine and access

Managers who need an "at-a-glance” look at geographic data

Organisations that want to present electronic interpretive maps

Public agencies that can save staff time by making records available to the public who can access the data from a conveniently-
located terminal

Students in elementary, high school, and college, who can use mapping as a fun way to become geographically literate, as well
as to improve their knowledge of computers

The public who wants to enquire about their community and its data




Training Manuai for Pelicy-Makers 224

How Does ArcView Compare with Other Desktop Mapping Systems?

ArcView is unique. There 15 no other solution that comes close to its unusual approach to organising and integrating geographic
information. ArcView can be considered to be a stand-alone desktop mapping and GIS solution, In this capacity, it (s far cheaper
and far more functional than any competitive products. ArcView is alswo a network product and will have the capability of

providing full integration between desktop computing users and large GIS repositories.

Beyond its architecture, ArcView has the additional benefit of being compatible with nearly one billion dollars worth of data that
have been converted into the ARC/TNFO format. There are thousands of ARC/INFO user organisations that have historically
developed or are currently developing smart geographic databases that can be used immediately by ArcView users.

Major Features of ArcView

What are ArcView's features? In a nuishell, it provides the following capabilities.

Visualisation: tools including raster /vector display, pan and zoom, and multiple windowing

Map Legeeuls tools for easily creating user-defined legends and map classes

Sprequlsire!. tools that fully integrate the functionality of a spreadsheet with the functionality of a GI5

Selection tools for spatially selecting a feature by pointing to it with the cursor or by creating a box, polygon. or circle
around a set of features. Addilional tools are used to manipulate and view attributes of their selections in a
spreadsheet type of format

Logwal
manipulation:  tools for logical modelling of tabular data with closelv-integrated visualisation tools for graphic representation of
the map model

Statistical tools:  tools to calculate and summarise statistics about a geographic feature or set of features

Planming: tools that output hard-copy graphics on a host of ESRl-supported hardware devices, as well as tools for
generation of industry-standard files, such as PostScript, for easy integration with other desktop applications

PR e T



Because ArcView is an entirely new product, its design is based on a new approach to working with geographic information. This
new approach builds a conceptual model of a user's perception of geographic data into the graphic user interface, resulting in a
maore intuitive approach to working with geographic data,

The View. The fundamental concept of ArcView s a view. A view & an organising principle for managing information about
geography. Views are dynamic in that they can be updated and modified in the geographic database. Views can also be saved.
This means that you can save & view, T:lﬂrﬂ'lnu then restore the view in ArcView some time later. You can also define
multiple views of the same geographic database, @ view can also be created from a variety of different data sources. A view is
made up of a collection of themes.

The Theme. A theme is the representation of a geographic topic of
imterest. Tt can be derived from any one of several geographic data
View sources, including ARC/INFO coverages, image data, or GRID or
TIN dats. An ARC/INFO coverage can be represented as an
individual theme, or several themes can be derived from a

Themes coverage representing various categories of features contained
within a coverage. For example, you could derive the themes

Legends “highways™ and “routes™ from the coverage “roads™ based on
attribute information.

Coverages

A theme also has an associated legend, which governs the
Feature Types rendering of features within the theme based on an attribute value,
The simplest legend contains one symbol, with which every
feature within the theme would be rendered identically. Another

legend might contain many different symbols  allowing
symbuolisation of features based on attribute valoe.
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Legends. Legends are an organised set of symbols associated with some property of a theme. A legend s a table organised by a
value or a range of values through which a symbol definition may be acquired. For example, a legend of road symbols published
by the US. Geological Survey and organised by a minor attribute code could be used to render any feature that had corresponding
values. That is, if @ user had an arc feature with the attribute value "40005" and the feature was rendered using the USGS legend, it
would be drawn with the symbology specified by the LSGS for that value. If the user then wished to render the map adhering to
another standard, a different legend could be loaded.

Table of contents. The lable of combenis is a graphic obpect with which the user interacts.  The table ol contents is used to organise
the themes of a view. While it is not the view itself, it does reflect the view by listing the themes currently defined for the view, the

status of themes, and their symbology or legend. As the table of contents of a book reflects the contents of a book,
ArcView's table of contents reflects the contents of the view.

The table of contents is not simply a static representation of the contents of a view, but an object that s manipulated interactively
to facilitate view operations and theme manipulation. For example, adding and removing themes from the current view, changing
the symbol or creating a legend for a given theme, or toggling a theme rom “visible™ to "invisible™ is done by interacting with the
table ol contents.

The ArcView interface incorporates two types of windows withan the interface design.  These windows are called the ArcView
Map Window and the ArcView Base Window.

Map window. The map windowr is the main graphic canvas on which geographic features are rendered. It supports pan and zoom
for control of spatal scene extent. [t reports the current location of the screen cursor in the coordinate system of the
view and indicates the coordinates of the current spatial scone extent. Liki the table of contents, the map window also reflects the

view, The themes specified in the table of contents control the contents ol the map window.

Multiple map windows can be displayed for the current view. This allows you to have one window that may be used as a
reference map, while other windows can be used 1o zoom in for a close-up view of speafic areas, or even display different themes
n different windows

The map window provides tools represented in scomc form, with whach spatial quernes can be made.




ArcView Tables. Another window in which user interaction with themes can occur is each theme’s table. This window displays
the attribute information associated with the theme, and it provides tools with which to perform logical selection, generate
statistics, and to save reports separately, etc.

Multiple Platforms and
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Coniznts and oter ke 1P B0 1 240 wiw necessary for multiplatform
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, 24
Table of - : Teese 14002 L0OVIOE new breakthroughs in user interface
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. Contanin i w; i CONUOT design tools, ArcView will be
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o legends witl VR Chgltle. windowing environments. This
Wpca-twva H ﬁ“f?:ﬁ"ﬁ:ﬂg&m means that ArcView will work on
1 o b f
UNIX workstations, PCs, and there

will even be a Macintosh version.

The PC and Macintosh versions will be able to access ARC/INFO databases over a network or as stand-alone platforms. Also,
because each of these platforms support windowing environments, ArcView will have a similar look and feel no matter what
platform the user is working on.

Another significant operational breakthrough for ArcView will be its ability to be a 100 per cent data compatible across all
platforms that support ArcView. This means that ArcView will “know” the binary structure in which ARC/INFO geographic data
sources are stored on all supported platforms.
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This data compatibility makes ArcView “network intelligent,” that is, ArcView will be able to find and access supported data
anywhere on a network. For instance, if you have ArcView running on your PC and your PC is on an Ethernet network of PCs
and workstations, ArcView will be able to access your local data or data on any of the workstations on the network. If you have
Macintoshes connected to the network, the Macintosh version of ArcView will also be able to access workstation data on the

network. This capability will be supported on local area PC networks; workstation Ethernet networks; and mixed Ethernet
networks having PCs, Macintoshes, and workstations.

Release Plan

ArcView is a completely new product for ESRI. It will be released in several phases on the UNIX workstation. The release plan
provides a useful product to UNIX users this summer. The PC and Macintosh versions of ArcView will be released later in 1991.

How Do I Get It?

ArcView is the most affordable GIS data access tool you can buy. To order your copy of ArcView, call ESRI's Marketing
Department (telephone: 714-793-2853), your regional office, or your international distributor.



Appendix B

PC-tased GIS Hardware Configuration

A. Computers

486 DX2 66 MHZ / Pentium 60/90
8/16 MBRAM

500 MB or Harder Disk

1,44 MB Floppy Disk

SVCA 15" Monitor w/ 1 MB VRAM
Enhanced Keyboard

Mouse

Optional: CD-ROM / Multi-media Kit
Backup system: Streamer tape or Magneto Optical Disk Drive
Brand : Original Brand 113M/Compaq/ AST/ Dell etc.

B. Power System

600 VA -1 KVA UPS
for each computer

Brand: AVC/ Best or any other
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C.

Digitizers
Al size Digitizer w/ 16 button cursor

Size could vary according to User's need
Brand: Calcomp / Summagraphics

Plotters

1. HP Designjet 250 C
2. HP Designjet 750C -Al or Al size

Printers

1. HP laserjet 4 M Plus Laser prinder - up to Ad size
2. Tektronix Colour laser printer - up to A3 size

Scanners

1. HF Scanjet |l ¢ up lo A3 size
<. High Resolution Colour Scanners

Tangent/ Vidar/ Microb - up o Al size




Software Used in MENRIS Appendix C

ARCIINFO Version 7.0 o ERDASPC7S
e vyt

PC ARC/INFO 342 <~ LwWIS14
ESRI, Recliancls, CA, UUSA ITC. Natheriands

ILLIS

womru | (DRIST moea
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Release 11.3
ESR1, Rediands, CA. USA

AutoCAD for Windows
Release 12

Version 1.3.0
ESRI Garmnaery

1%

Map Viewer
Thematic Mapping for Windows
Golden Softwars, inc. CO, USA

SURFER for Windows
Version 6.0

Golden Softwars, inc. CO. USA

GRAPHER for Windows
Golden Softwars. Inc. CO, USA
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Participating Countries of the Hindu Kush-Himalayan Region

* Afghanistan * Bangladesh
= Bhutan * China

= India *« Myanmar
= Nepal * Pakistan

International Centre for Integrated Mountain Development (ICIMOD)
4/80 Jawalakhel, G.P.O, Box 3226, Kathmandu, Nepal

Telephone : 977 1525313 Telex : 2439 ICIMOD NP
Facsimile : 9771 524509 Cable : ICIMOD NEPAL
977 1524317





